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Notes on Freeware Edition

From an initial inception as a IIgs communications program 
called Impala, Spectrum was developed and released under the 

guidance of Dave Hecker of Seven Hills International. Originally 
released back in 1991, it was sold by Seven Hills until their 

eventual closure. 

Seven Hills agreed I could continue to sell Spectrum, so I asked 
Eric Shepherd of Syndicomm to sell Spectrum on my behalf. In 
2011 Tony Diaz took over Syndicomm and continued to sell it for 
me. With the declining sales over the years, I finally decided that 

the time had come in 2012 to make Spectrum Freeware.

To coincide with its reclassification, this PDF manual has been 
compiled from the original Seven Hills manuals. I have changed 

a few words and links here and there, and added new screen 
shots and illustrations.

Ewen Wannop - 2012
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Spectrum

About Seven Hills Software

No Copy Protection
We don’t believe in copy protection—all it does is impair the honest user’s ability to use software to its fullest. We strive to 
provide high quality products at reasonable prices. We hope you will support our efforts by not allowing your family or friends 
to copy this software.

Questions and Comments
We always welcome feedback—if you have any questions, or suggestions for improving this product, please let us know. In 
addition, we would like to hear your ideas for new programs.

Copyrights and Trademarks
This manual and the software (computer program) described in it are copyrighted with all rights reserved. No part of the 
Spectrum software or documentation may be reproduced, stored in a retrieval system, or transmitted, in any form or by any 
means, mechanical, photocopying, recording or otherwise, without the prior written permission of Seven Hills Software 
Corporation.

SEVEN HILLS SOFTWARE CORPORATION’S LICENSOR(S) MAKES NO WARRANTIES, EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, REGARDING THE SOFTWARE. SEVEN HILLS SOFTWARE CORPORATION’S 
LICENSOR(S) DOES NOT WARRANT, GUARANTEE OR MAKE ANY REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF THE USE OF THE 
SOFTWARE IN TERMS OF ITS CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND 
PERFORMANCE OF THE SOFTWARE IS ASSUMED BY YOU. THE EXCLUSION OF IMPLIED WARRANTIES IS NOT PERMITTED BY SOME STATES. THE ABOVE 
EXCLUSION MAY NOT APPLY TO YOU.

IN NO EVENT WILL SEVEN HILLS SOFTWARE CORPORATION OR ITS LICENSOR(S), AND ITS DIRECTORS, OFFICERS, EMPLOYEES OR AGENTS BE LIABLE TO 
YOU FOR ANY CONSEQUENTIAL, INCIDENTAL OR INDIRECT DAMAGES (INCLUDING DAMAGES FOR LOSS OF BUSINESS INFORMATION, AND THE LIKE) 
ARISING OUT OF THE USE OR INABILITY TO USE THE SOFTWARE EVEN IF SEVEN HILLS SOFTWARE CORPORATION OR ITS LICENSOR HAS BEEN ADVISED 
OF THE POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR 
INCIDENTAL DAMAGES, THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU. SEVEN HILLS SOFTWARE CORPORATION OR ITS LICENSOR(S) LIABILITY TO YOU 
FOR ACTUAL DAMAGES FROM ANY CAUSE WHATSOEVER, AND REGARDLESS OF THE FORM OF THE ACTION (WHETHER IN CONTRACT, TORT (INCLUDING 
NEGLIGENCE), PRODUCT LIABILITY OR OTHERWISE), WILL BE LIMITED TO $50.

Apple, IIgs, GS and GS/OS are trademarks of Apple Computer, Inc.

Spectrum © 1991-2003 Ewen Wannop
Spectrum is a trademark of Seven Hills Software Corporation
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About Spectrum

Spectrum™ is a telecommunications program written specifically for the Apple IIgs. It uses 
the standard Apple IIgs “desktop interface” so it’s powerful, yet easy to learn and use.

The simplicity of the IIgs desktop interface, and the memory available in the IIgs, allows many 
features in Spectrum that are not practical in ordinary communications programs.

A powerful scripting language allows Spectrum to be tailored specifically for individual use. 
Scripts can do almost anything, ranging from emulating an electronic bulletin board to the 
daily automatic logging, sending and retrieving of mail.

Spectrum is an expandable program that allows access to many different “host” computers 
and systems. In addition to the standard Super Hires screen display, Spectrum can use an 80 
column text screen display. Additional “drop in” displays are also provided (ANSI, ProTERM™ 
Special, Viewdata, VT100, etc.).

Our goal was to make Spectrum a very useful tool so it would be valuable to you. By making 
a quality program available at a reasonable price, we think we have succeeded. 

Seven Hills Software Thanks…
Ewen Wannop for his incredible patience and skill writing Spectrum.
Kathryn Beth Willig for getting us together with Ewen; we miss you.
Richard Bennett for an amazing port routine, great online displays, and his patience answering so many 
questions.
All our beta testers and user group Partners for their guidance and support.
And you, for supporting our IIgs publishing efforts!

Spectrum

Welcome to Spectrum
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Note from the Author…
Spectrum has taken me many years to complete. In fact, I originally bought my IIgs to write 
the program. I have had many steep learning curves during this period, and have changed 
my mind a number of times. Finally I got to the point where the program was a true, working 
reality.

At the time, I was a full time lecturer in desktop publishing and computer graphics at an art 
college in England. I was also a Sysop of the TABBS Bulletin Board. The programming (in 
APW assembler) was done in any spare moments that I had left… hence the time it took to 
gestate Spectrum!

When I set out to write Spectrum, there were no communications programs like America 
Online or CompuServe Information Manager to model it on, so Spectrum was conceived of as 
a conventional communications program. From the outset, I had ideas for some unique 
features, most of which have made it into the final version.

Spectrum is my third major telecommunications program. My first two were very conventional: 
Data Highway, which runs under DOS 3.3, and Gazelle, which runs under ProDOS. Neither of 
these programs were ever sold openly in the US market, but were popular in Europe because 
both included Viewdata display drivers as well as 80 column displays. I also wrote 
Chameleon, a shareware file transfer utility.

I give my thanks to all those who have contributed to making this program possible, and 
especially to Woz (who created the environment) and to Dave Hecker (who patiently guided 
its progress).

I hope you find Spectrum as useful and enjoyable as I have!

About Spectrum
Read this manual to learn about using Spectrum to its fullest. The manual is divided into three 
main sections:

•  The Getting Started section guides you through one-time steps, including making a working 
copy of Spectrum.

•  The Guided Tour section gets you started using Spectrum.

•  The Reference section contains detailed information about Spectrum.

Enjoy!
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Things You Need To Know
Requirements
To use Spectrum you need:

•" An Apple IIgs with at least 1MB of memory.
•" One 3.5" disk drive (a hard disk drive is strongly recommended).
•" Apple IIgs System Software version 6.0 or later. NOTE: ”System 6” requires a computer ROM version of 

at least 01—when you turn on the computer, if the bottom of the screen does not show a version number, 
contact your authorized Apple dealer for an upgrade.

•" A modem connected to the modem or printer port on the back of the IIgs, or to an Apple Super Serial 
Card (and workalikes) in any slot. Spectrum is also compatible with Applied Engineering’s DataLink 
internal modem (and workalikes).

•" To print, you need any printer that works with a standard IIgs printer driver (we assume you have the 
appropriate printer drivers available to you). If you wish to print to a Hewlett-Packard DeskJet, 
DeskWriter, or LaserJet, you can purchase and use the Independence printer driver package.

•" If you use The Manager from Seven Hills Software, you must use version 1.1 for smooth operation with 
Spectrum.

Keys on Your Keyboard
Keys on the keyboard are referred to by the name printed on them (Delete, Option, A, etc.). The Command key 
is shown as .

Steps
Steps you should follow are indented and numbered. For example:

➀ " Use Spectrum.
➁ " Connect to almost any system in the world!

Getting Started

We know you are anxious to start using Spectrum, but please read this section first because it leads you through 
several important steps which you need to do only once:

•" Learning conventions and terminology
•" Getting your IIgs ready to start a IIgs-specific program
•" Making a working copy of Spectrum

After completing the Getting Started section, you will use the Guided Tour. It teaches you about Spectrum by 
showing you how to use several of its features.

Following the tour is the Reference section, which covers every aspect of Spectrum. It is the best place to look 
when you need added information or help with a particular feature.
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Mouse Terms
This manual uses four terms to describe the different ways you can use the mouse:

Clicking means quickly pushing down and releasing the mouse button while the mouse remains motionless. 
One use of clicking is to select a command.

Double-Clicking means quickly clicking twice. Double-clicking is commonly used as a shortcut for some action. 
For example, double-clicking on a folder opens that folder.

Pressing means holding the mouse button down while the mouse remains motionless. The most common use 
is pressing on a scroll bar’s arrow to cause the document to scroll until the mouse button is released.

Dragging means holding the mouse button down, moving the mouse to a new position and finally releasing the 
mouse button. Common uses are choosing a menu item and moving or resizing a window.

Installing Onto 3.5” Disks
This section describes installing Spectrum onto 3.5" disks. If you are installing Spectrum onto a hard disk drive, 
skip to the section titled “Installing Onto A Hard Disk Drive.”

NOTE: When using Spectrum with 3.5" disk drives, the “Spectrum Sounds” disk is not used at all—
please store it in a safe place.

Locate Your System 6 “System.Disk”
Spectrum requires the Apple IIgs System Disk, version 6.0.0 or later. You should have several System 6 master 
disks. Locate the one labeled System.Disk, then skip to the next section, “Start The Computer.”

If you do not own System 6 you can purchase it from Syndicomm:  http://store.16sector.com/

Your local user group may also have it available.

Start the Computer
Follow these steps to start the computer:

➀ " Insert the original System 6 disk labeled System.Disk into the startup disk drive.
➁ " Turn on the monitor and computer (if the computer is on already, hold -Control down and press Reset). 

The 3.5" disk drive will come on and begin loading Apple’s Finder. NOTE: If you did not set your 3.5" 
disk drive to be the startup slot, the computer will try to start up from some other disk drive. If you get 
the message “Check Startup Device,” hold Control and press Reset. At the prompt type PR#5 (assuming 
your 3.5" disk is in slot 5) and press Return.

Personalize Spectrum
Follow these steps to personalize Spectrum. NOTE: These steps must be followed using the original 
Spectrum disk, before you make a working copy.

➀ " Make sure the original disk labeled Spectrum is not write-protected. That is, make sure you cannot see 
through the hole in the upper-right corner of the disk.

➁ " Insert the original disk labeled Spectrum (if you have only one 3.5" disk drive you will have to eject the 
Startup Disk). A window titled “Spectrum” should appear…if not, choose Open from the File menu.

➂ " Click on the Install icon to select it.

http://store.16sector.com
http://store.16sector.com
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➃ " Choose Open from the File menu. If you have only one 3.5" disk drive you will be prompted to switch 
disks. When you are asked to insert a particular disk, insert it and click OK.

➄ " When you are asked to do so, type your full name then click the OK button.

Soon Apple’s Installer window is displayed. However, you will not use the Installer because you are installing 
onto 3.5" disks. Therefore:

➅ " Choose Quit from the File menu and the Finder reappears.

Make Working Copies
Please take the time to make a working copy of each of the supplied disks. After making your working copies, 
store the original disks in a safe place so if a problem ever develops with a working copy another can be made 
from the original disk. If a problem ever develops with an original disk, you can download a new copy from http://
www.wannop.info/speccie.

NOTE: Throughout this entire section you will be using both the original disks and your working copies—you will 
not be done with the original disks until you begin the Guided Tour section. The original disks are safe as long as 
you can see through the hole in the upper-right corner of the original disks.

Initialize Two Disks
Before proceeding, protect the original Spectrum disk by making sure that it is write-protected! Look at 
the hole in the upper-right corner—the disk is write-protected if you can see through the hole. If you 
cannot see through the hole, slide the tab so you can.

To make a working copy of Spectrum you need two initialized (but otherwise blank) 3.5" disks:

" "  " Startup" "  Program

"
Repeat these steps to initialize each disk:

➀ " Insert a blank disk into a 3.5" disk drive.
➁ " When you are told “GS/OS can’t read this disk. Do you want to initialize it?” click the Initialize button. 

NOTE: If you do not see this message and instead a disk icon appears on the desktop, make sure the 
disk is one that can be destroyed! If it is, choose Initialize from the Disk menu (never initialize an original 
Spectrum disk).

" A dialog box appears, in which you can specify the disk’s name, format, size, and interleave.
➂ " Type a name for the disk (e.g. Startup or Program). Do not change the suggested format or size/

interleave options.
➃ " Click Initialize and the process is begun. If the disk is initialized successfully, a new disk icon appears on 

the desktop (use another disk if an error occurs).
➄ " Drag the new disk icon onto the Trash icon. This ejects the disk and removes its icon from the desktop.
➅ " Label the disk with the correct name (Startup or Program).

After initializing and applying a label to the two disks, you are ready to copy the original disks.

http://www.versiontracker.com/
http://www.versiontracker.com/
http://www.versiontracker.com/
http://www.versiontracker.com/
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Copy the Disks
Before proceeding, protect the original Spectrum disk by making sure that it is write-protected! Look at 
the hole in the upper-right corner—the disk is write-protected if you can see through the hole. If you 
cannot see through the hole, slide the tab so you can.

Follow the steps below to make an exact copy of each of the supplied disks:
➀ " Insert the disk you want to copy onto (one of the disks that you initialized and hand-labeled). The first 

“destination disk” is the disk hand-labeled Startup, so insert that disk (eject a disk if necessary).
➁ " Insert the disk you want to copy from. The first “source disk” is the System 6 disk labeled System.Disk, 

so insert that disk (eject a disk if necessary).
➂ " Drag the original disk icon onto the hand-labeled disk icon: Position the arrow pointer over the original 

disk icon, hold down the mouse button, drag onto the hand-labeled disk icon (it turns black) then release 
the mouse button. The first copy is made by dragging the System.Disk icon onto the Startup icon.

➃ " The Finder asks if you want to replace the contents of the destination disk with the contents of the 
source disk. Click OK to proceed. NOTE: If you get a message stating that the destination disk is write-
protected, you are trying to copy in the wrong direction—click the Cancel button and go back to step 3, 
making sure you drag the source disk icon onto the destination disk icon.

During the copy process the Finder may ask you to insert a particular disk. Find the desired disk and insert it to 
continue.

When the Finder is finished copying the disk,
➄ " Drag the source disk icon onto the Trash icon. This ejects the disk and removes its icon from the 

desktop.
➅ " Drag the destination disk icon into the Trash to eject it and remove its icon from the desktop.

Repeat steps ➀– ➅ for each of the following disks:

" Drag:" Onto:
" System.Disk" Startup
" Spectrum" Program

Remove Unnecessary Files

Your working Program disk currently contains files that you won’t need. These files can be removed to give you 
more disk space.

➀ " Insert your hand-labeled Program disk.
➁ " Drag the “Install” icon into the Trash.
➂

 Drag the “Misc.” folder icon into the Trash.
➃ " Drag the Program disk icon into the Trash to eject the disk and remove its icon from the desktop.

Shut Down
Now shut down the system to stop using the original disks:

➀ " Choose Shut Down from the Special menu.
➁ " Click OK to Shut Down (turn off system power). Store both original Spectrum disks in a safe place.

Skip to the Guided Tour section to begin using Spectrum.
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Installing Onto A Hard Disk Drive
This section describes installing Spectrum onto a hard disk drive. If you are installing Spectrum onto 3.5" disks, 
go back to the section titled “Installing Onto 3.5" Disks.”

System 6.0.1 Required
Spectrum v2.3 requires Apple IIgs System Software version 6.0.1 or later. If System 6.0.1 isn’t already installed 
on your hard disk drive, use the System 6.0.1 master disks to install it.

If you do not own System 6 you can purchase it from Syndicomm:  http://store.16sector.com/

Your local user group may also have it available.

Install Spectrum

Start the Computer

Installing Spectrum on a hard disk drive is easy…just follow these steps:
➀

 Start up your hard disk drive and your Apple IIgs just as you usually do.

Personalize Spectrum

When you reach the point where you can launch an application,
➀ " Make sure the original disk labeled Spectrum is not write-protected. That is, make sure you cannot see 

through the hole in the upper-right corner of the disk.
➁

 Insert the original disk labeled Spectrum into a 3.5" disk drive.
➂

 Launch the “Install” program.
➃ " When you are asked to do so, type your full name and click the OK button.

Install Spectrum

Soon Apple’s Installer window is displayed. The scroll box contains “scripts” that can be used to install 
Spectrum.

➀ " Click the Install button and Spectrum with its icons are copied to the disk that was used to start up the 
computer. NOTE: If you want to install Spectrum to some other disk, click the Disk button until that disk 
is displayed.

➁ " If you want to install sounds that are played automatically by Spectrum, highlight the “Install Spectrum 
Sounds” script, then click Install.

➂ " After Spectrum is installed, click the Quit button.

Shut Down

If you only installed Spectrum (i.e. you did not install the sounds):
➀ " Wait until the Finder appears (the program with the disk icons and Trash icon).
➁ " Choose Shut Down from the Special menu.
➂ " Click OK.
➃ " Store both original Spectrum disks in a safe place.

http://store.16sector.com
http://store.16sector.com
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If you installed the sounds:
➀ " Click the Restart System button to restart the computer.
➁ " Eject the original Spectrum disk, and store both original Spectrum disks in a safe place.
➂ " When the computer is restarted, choose Control Panels from the  (Apple) menu.
➃ " Open the “Sound” CDEV (scroll down if necessary to find it). The system will gather the names of all the 

new sounds, thus making them available to Spectrum.
➄ " When you can proceed, close the Sound window, then close the Control Panels window.

That’s it! Spectrum is now installed and you’re ready to begin the Guided Tour section.
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The Guided Tour section guides you through several Spectrum features. Complete information about each 
Spectrum feature can be found in the Reference section.

IMPORTANT: If you have trouble with dropped/missing/lost characters when communicating with 
Spectrum, be sure to read the “Check Your System Extensions” section in this manual!

Starting Spectrum

Using 3.5" Disks
Make sure you cannot see through the write-protect holes on your hand-labeled Startup and Program 
disks. Spectrum and the system will not operate properly if you try to operate with write-protected disks.

To start Spectrum from the working copies of the original 3.5" disks, follow these steps:
➀ " Insert the disk hand-labeled Startup into the startup disk drive.
➁ " Turn on the monitor and computer (if the computer is on already, hold -Control down and press 

Reset). The 3.5" disk drive will come on and begin loading Apple’s Finder. NOTE: If you did not set your 
3.5" disk drive to be the startup slot, the computer will try to start up from some other disk drive. If you 
get the message “Check Startup Device,” hold Control and press Reset. At the prompt type PR#5 
(assuming your 3.5" disk is in slot 5) and press Return.

➂ " When the Finder appears, insert the disk hand-labeled Program (if you have only one 3.5" disk drive 
you’ll need to eject the Startup disk first).

➃ " Click on the Spectrum folder icon to select it, then choose Open from the File menu.
➄ " Select the Spectrum icon, then choose Open from the File menu.

If you have only one 3.5" disk drive you will be prompted to switch disks as Spectrum is loading, and while using 
Spectrum. When you are asked to insert a particular disk, insert it and click OK.

Skip to the next section, “Introducing Spectrum.”

Using A Hard Drive
Follow these steps to start Spectrum from the hard drive:

➀ " If it is not already started, start up your hard disk drive and your Apple IIgs just as you usually do.
➁ " When you reach the point where you can launch an application, launch Spectrum (it is located in a 

“Spectrum” folder on the main level of the drive that you installed onto).

Guided Tour
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Introducing Spectrum
After the program is loaded, you’ll see Spectrum’s menu bar at the top of the screen. The first time you launch 
Spectrum you will be given a brief tour. Follow the directions on the screen. After the tour is complete, 
continue reading here.

Check Your System Extensions
“System extensions” are things such as Control Panels (CDEVs), Desk Accessories (CDAs and NDAs), and 
System Setup files (INITs). All active extensions require some memory, and that memory is not available to 
applications. If you have just 1MB memory you should consider removing or inactivating any unnecessary 
extensions to give Spectrum the most memory possible.

Spectrum has been tested with a variety of extensions and we believe it has no serious operational problems. If 
you suspect there is a problem with Spectrum, follow these steps:

➀ " Shut down and turn off your computer.
➁ " Hold down the Shift key and turn on your computer. Continue holding down the Shift key until the 

“Welcome to the IIGS” dialog box says “No INITs/DAs”—this tells you that no extensions will be active.
➂ " Launch Spectrum.
➃ " When a note informs you that the Hierarchic init is not loaded, click the Load button and Spectrum will 

continue its startup process.

Once Spectrum has been started after a “Shift boot,” see if the problem still exists. If the problem disappears 
then one or more of your system extensions is causing the problem. If the problem persists, read the “Questions 
and Answers” section of this manual to see if the problem you’re having has a simple explanation. If you need 
further help, please contact us.

Warning About Interrupts

Some system extensions need to get control of the computer every so often in order to perform a task. There 
are two basic ways to do this. Some extensions, like our Express printer spooler, get control by using the run 
queue. This is a very friendly way to get control because the system is never interrupted; instead, the extension 
is called only when the system is available.

Other extensions, however, get control by using an interrupt. Getting control through an interrupt is less friendly 
to the system, but is a perfectly legitimate method provided it is done properly. Specifically, an interrupt routine 
must perform its task very quickly, so that other parts of the system do not suffer in performance.

Spectrum’s port driver is “interrupt-based” and runs very quickly. However, in order to not lose characters, it 
relies on getting interrupts regularly. Because other interrupt-based extensions are also competing for interrupt 
time, the more of these extensions you have, the more likely it is that Spectrum will lose characters (especially 
at high baud rates). And if an interrupt-based extension takes too much time to do its job, even more characters 
will be lost.

If you know you have a good phone connection but you find that characters are being dropped regularly (or file 
transfers are slower than they should be), it is very likely that one of the extensions on your startup disk is 
causing the problem.

The following extensions that have been known to cause character loss: Cool Cursor, ProSel’s “Appointments”, 
SHR 10-Second Saver CDA, ShowMe, SoundMeister, Twilight II. NOTE: There may be newer versions available 
that no longer cause a problem. Contact the author or publisher to see if you have the latest version.

We are sure there are other extensions that cause problems; this list contains just the ones we were aware of at 
the time this manual was printed. Please let us know if you find any extension that causes problems.
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Getting Connected
Because there are too many factors in connecting to a host we cannot provide specific steps to show as an 
example. However, the general process is as follows:

➀ " Create a phonebook entry for the host (see “Dial Number”). Although it is not necessary to create a 
phonebook entry for every system you call, it is usually more convenient to do so.

➁ " Dial the phonebook entry (see “Dial Number”).
➂ " After connection to the host, follow the instructions the host gives you to log on.

The best way to learn how to use Spectrum is by actually using it. Once you are connected (we recommend 
connecting to a free, local bulletin board for your experiments) you can experiment with turning Spectrum’s 
capture buffer on and off, sending and receiving files, and so on.

After you are familiar with Spectrum, try using Scripts to automate repetitive tasks, such as logging on to a 
system or reading your mail.
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The Reference section describes all the features found in Spectrum. This section is organized for reference—
use it to learn about a specific feature.

A particular topic or command can be found in the Table of Contents or Index.

Menus
Menus contain all the commands available in Spectrum. The titles of all the menus are shown in the menu bar at 
the top of the screen. To see the commands available in a menu, pull it down by pointing to its title and pressing 
the mouse button. When a command is dim it is not available at the moment.

This section is organized by the menu titles and menu commands.

Command Keys
Many commands have keyboard shortcuts that let you give the command without using the mouse. These 
shortcuts are listed to the right of the corresponding commands in the menus. For example, pull down the File 
menu and you will see several keyboard shortcuts listed:  N for New,  O for Open, and so on.

To use a keyboard shortcut, hold down the Command key ( ) and press the letter listed on the menu. The 
Command key has a hollow apple and a cloverleaf on it, and is located between the Option key and the tilde key 
at the lower-left of the keyboard. NOTE: Although shortcuts in this manual are shown as uppercase, all 
Spectrum shortcuts can be accessed by holding the Command key and typing either a lower case or upper case 
letter.

Hierarchic Menus
Spectrum uses a familiar menu bar at the top of the screen, with an 
important addition: Some of the menu items are “hierarchical” (a 
fancy way to say that a “sub-menu” of choices will appear when 
you highlight a main menu item).

A menu item has a sub-menu if it has an arrow icon where a 
keyboard shortcut would normally appear. In the menu above, the 
Send File, Receive File, and Capture to File items will each present 
a sub-menu.

Using A Hierarchic Menu

Using a hierarchic menu is similar to using a regular menu: You 
just highlight the option you want. Here’s how:

➀ " Pull down a menu that contains a hierarchic menu item. 
For example, pull down the File menu.

Reference

A hierarchical menu
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➁ " Drag the mouse down to highlight that hierarchic menu item and a sub-menu appears. For example, 
highlight the Receive File menu item.

➂ " With the main menu item still highlighted, drag the mouse directly to the right (do not drag up or down 
off the main menu item).

➃ " Once an item on the sub-menu is highlighted, drag down to highlight an item on the sub-menu, then 
release the mouse button. For example, highlight Xmodem then release the mouse button. NOTE: If you 
are following the example, click the Cancel button to continue.

Changing Menu Delays

When you were trying to select an item on the sub-menu, you might have accidentally dragged off the main 
menu item before a sub-menu item was highlighted, causing the sub-menu to disappear. That is why the step 
cautioned to drag the mouse directly to the right.

If you always had to be that exact, using hierarchic would be a chore. Fortunately there are two settings that can 
be adjusted for hierarchic menus: An “Initial Delay” and a “Drag Delay.”

The Initial Delay determines how soon a sub-menu will appear after highlighting a main menu item. The Drag 
Delay determines how long the sub-menu will stay open, even if you drag off the main menu item.

To change these settings:

➀ " Hold down the  and Control keys. While still holding down those two keys, press and release the 
Escape key. The normal desktop disappears and the text-based “classic” Desk Accessory menu 
appears.

➁ " Press the Down Arrow to highlight the “Hierarchic Settings” option, then press Return. This opens the 
“Hierarchic Settings” desk accessory.

Each delay is set to 0/60ths (no delay), but it is easier to choose sub-menu items if there is a delay. Delays are 
specified in “60ths of a second.” For example, 1/2 second is 30/60ths of a second; 1 second is 60/60ths; 2-1/2 
seconds is 150/60ths and so on. The longest delay that can be set is 254/60ths (slightly over 4 seconds).

To increase each delay:
➂ " The Drag Delay option is already highlighted. Hold down the Left Arrow until the number is 240/60ths 

(four seconds).
➃ " Press the Down Arrow to highlight the Initial Delay option.
➄ " Hold down the Right Arrow until the number is 60/60ths (one second).
➅ " Press Escape to highlight the Quit option and press Return to go back to the classic Desk Accessory 

menu.
➆ " Press Escape to highlight the Quit option and press Return to go back to the normal desktop.

To see the effect the delays have, repeat the earlier steps to highlight an item on the sub-menu…but instead of 
dragging directly to the right, this time drag down and to the right, making a “beeline” for the desired item on the 
sub-menu.

As you do this, you’ll notice that the sub-menu does not appear immediately; it appears only after the main 
menu item is highlighted for one second (the Initial Delay).

Next you’ll notice that even though you drag off the main menu item, the sub-menu does not disappear (the 
Drag Delay).

As you become more familiar with using hierarchical menus, you will probably want to reduce the delays 
significantly (we use a drag delay of 120/60ths and an initial delay of 15/60ths). NOTE: Even with a long drag 
delay, fast vertical mouse motion will cause the sub-menu to disappear before the specified delay. This is 
intentional to avoid a long delay if you accidentally highlight the wrong menu.
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 (Apple) Menu

About Spectrum

Choose About Spectrum to display the program’s version number and copyright information.

About Spectrum dialog box

Help

Choose Help to display the online help. An error is displayed if the file “Spectrum.Help” cannot be found in the 
“Add.Ons” folder, or if there is insufficient memory to load it.

Desk Accessories
IMPORTANT: If you have trouble with Spectrum, be sure to read the “Check Your System Extensions” 
section in this manual!

New Desk Accessories

New Desk Accessories (NDAs) you installed appear under the (Apple) menu. NDAs are stored in the 
System:Desk.Accs folder of your startup disk (filetype $B8).

To use an NDA, choose it from the  (Apple) menu like any other command. For information about using a 
particular NDA you must refer to the documentation that came with it.

Control Panel

Control Panel lets you change various system-related options, including your printer setup. Refer to the 
documentation that came with your Apple IIgs for information about changing the printer type and connection 
method.

Classic Desk Accessories

To access any Classic Desk Accessories (CDAs) stored in the System:Desk.Accessories folder of your startup 
disk (filetype $B9), hold down -Control while you press and release Esc.

For information about using a particular CDA you must refer to the documentation that came with it.
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File Menu

New

Shortcut:  N

Choose New to clear the online display (if the online display is frontmost) or to start a new editor document (if 
the editor window is frontmost). If the current editor document needs to be saved, you will be asked if you want 
to save changes first.

Open Editor Document

Shortcut:  O

Choose Open Editor Document to open a Text, Teach, or AppleWorks document in the editor. If the current 
editor document needs to be saved, you will be asked if you want to save changes first. TIP: To open the data 
fork of a file that is not a Text, Teach, or AppleWorks document, hold down the Option key before choosing Open

Close

Shortcut:  W

Choose Close to close the frontmost window (e.g. the online display window, the editor window, a desk 
accessory, etc.). NOTE: If you are using an online display that does not provide access to the File menu, 
press  W to close the online display and return to the standard desktop.

When you close the editor window you will not be asked if you want to save it, because closing just hides the 
window. This ability lets you keep text in the editor while you are online; you can make notes in the editor or 
compose a message reply that can be sent using the “Send Editor Text” command.

Save

Shortcut:  S

Choose Save to save the contents of the frontmost window. If a file name is needed you will be asked to specify 
its name and location. At the same time you can specify the file format to use (Text, Teach, or AppleWorks).

Save As

Choose Save As to save the contents of the frontmost window. You will always be asked to specify the name 
and location for the file, as well as the file format to use (Text, Teach, or AppleWorks Classic).

Send File

NOTE: See the “Transferring Files” section for more information about the following protocols.

After instructing the host that you will be sending a file, choose the appropriate protocol from the Send File sub-
menu.

CIS B+, Xmodem, 1K Xmodem, 4K Xmodem

These protocols can send any single file; after choosing one of these you are asked to select the file to send.
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Ymodem Batch, Ymodem-g, Zmodem

These protocols can send either a single file or several files at a time; after choosing one of these you are asked 
to select the file(s) to send. To highlight multiple files, hold down the Shift key when clicking to select ranges of 
files, or hold down the  key to select individual files. Folders can also be selected, but they will be ignored.

Text File

Shortcut:  I

Choose Text File from the Send File sub-menu to send the contents of a Text, Teach, or AppleWorks document. 
While selecting the file to send you can also set these options:

A portion of the Send Text File dialog box

Display and capture to buffer: When this option is checked, the text is displayed and captured to the buffer 
just as if you were typing it. When this option is not checked, the text is sent using the “file transfer status” dialog 
box.

Prompted: This option is dim unless a prompt character is specified in the File Transfer Settings dialog box. 
When this option is checked, Spectrum starts sending the text but at each Return character it waits up to 20 
seconds to receive the prompt character before sending the next line. When this option is not checked, the 
entire file is sent without waiting for any prompt.

NOTE: The text is sent using the character and line delays specified in the Port Settings dialog box.

Editor Text

Shortcut:  J

Choose Editor Text from the Send File sub-menu to send all the text that’s currently in the editor. Before sending 
the text you can set the following options:

A portion of the Send Editor Text dialog box

Format Paragraphs Into Lines: When checked, paragraphs are split into lines before being sent.

Display text and save to buffer: Same as when sending a text file (see above).

Prompted: Same as when sending a text file (see above). You can change the prompt character if desired.



File Menu 
 24

Receive File

NOTE: See the “Transferring Files” section for more information about the following protocols.

After instructing the host system to send you a file, choose the appropriate protocol from the Receive File sub-
menu to receive the file. NOTE: To capture incoming text to a disk file, see the Capture To File option (below).

CIS B+

This protocol receives a single file. After choosing Receive CIS B+ the file transfer occurs automatically and the 
received file is stored in the file transfer folder. NOTE: If the Auto Receive option is checked (File Transfer 
Settings dialog box), CIS B+ transfers are started automatically so you won’t have to choose this option.

Xmodem, 1K Xmodem, 4K Xmodem

These protocols receive any single file; after choosing one of these you are asked where to put the received file. 
The name you provide will be used unless a file with a MacBinary header is received, or a file with a Binary II 
header is received and the “Binary II Down” option is on. In those two cases the name that is enclosed in the 
header will be used.

Ymodem Batch, Ymodem-g

These protocols receive one or more files; after choosing one of these you are asked where to put the received 
file (the name is ignored, but must be valid in order for the dialog box to be accepted).

Zmodem

This protocol receives one or more files. After choosing Receive Zmodem the file transfer occurs automatically 
and the received file is stored in the file transfer folder. NOTE: If the Auto Receive option is checked (File 
Transfer Settings dialog box), Zmodem transfers are started automatically so you won’t have to choose this 
option.

Capture

Shortcut:  = (equal) 

Choose Capture to turn the capturing option on and off (a checkmark appears to the left of the menu item when 
Capture is on).

When Capture is not checked (off), text is not captured. When Capture is checked (on), text is stored either in 
the capture buffer or the capture file (if a checkmark appears to the left of the Capture To File option).

NOTE: If you want complete manual control over the capture option, be sure the Auto Buffer Control option is 
not checked (Online Display Settings dialog box). If checked, the host is able to control capturing…but only 
when the Capture option is off. This means that if you want data to be captured it definitely will be, but when you 
turn off the Capture option the host might still cause capturing to occur.

To the right of the menu bar is a thermometer that shows the current status of the capture buffer. The 
background of the thermometer is either green (the capture buffer is on) or white (the capture buffer is off). As 
the capture buffer fills, the thermometer fills with black.

If the capture buffer completely fills, Spectrum will ask whether you want to clear it, save it to a new file, or 
append it to an existing file.
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The “capture buffer is full” dialog box

Clear erases the contents of the capture buffer. Save lets you specify the name and location of a new file to 
save. Append lets you select an existing text file to append to.

The Save and Append options both include a “Keep appending if buffer fills” checkbox that determines what 
happens the next time the buffer fills. If the option is not checked then you will again be asked whether you want 
to Clear, Save, or Append it.

If that option is checked, new data will be appended automatically to the end of the same file with no further 
response from you. NOTE: Once this option is specified it stays in effect until you quit Spectrum, or run a script 
which includes a “Set AutoSaveBuffer Off” command.

Clear Capture Buffer

Choose Clear Capture Buffer to empty the capture buffer. Because captured text will no longer be available, 
Spectrum asks you to confirm your choice.

Capture To File

At times it might be useful to capture text directly to a file on disk instead of into memory. Highlighting Capture 
To File opens a sub-menu that contains two options: New File asks you to specify the name and location of a 
new file to begin capturing into. Existing File asks you to select an existing text file to append onto.

While capturing text to a disk file the “Capture To File” menu item is renamed to “Close Capture File.” Choose 
Close Capture File to close the disk file and resume capturing to memory. NOTE: Text is captured only if the 
Capture menu item is also checked.

Page Setup

Choose Page Setup to present the chosen printer driver’s Page Setup dialog box.

The Page Setup dialog box typically lets you specify information about the paper size and orientation you want 
to use (specific options depend upon which printer driver is selected). If there is a “Vertical Condense” option, 
the best quality print will be achieved if the option is checked.

Print

Shortcut:  P

Choose Print to print the contents of the frontmost window. The chosen printer driver’s Print dialog box appears, 
which typically lets you specify the number of copies, page range, quality, and so on (the actual choices depend 
upon which printer driver you are using). After specifying the options you desire, click OK and the text will be 
printed.

NOTE: Printing from a IIgs application can be slow, so it is recommended that you only print while offline. Using 
the Express printer spooler will help you regain control of the computer sooner, and you may even find it quick 
enough to accomplish small print jobs while online.
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Launch

Choose Launch to quit Spectrum and directly launch another GS/OS program. There are two options when 
launching an application:

A portion of the Launch dialog box

Hangup: When checked Spectrum will hang up before launching (if the modem stays connected, your online 
charges will continue to accrue). Uncheck this option only if you want to stay connected while you use some 
other application.

Return to Spectrum: When checked, quitting from the program you launched will restart Spectrum. If you don’t 
want to automatically return to Spectrum after using the program you’re launching, uncheck this option.

Quit

Shortcut:  Q

Choose Quit to stop using Spectrum and return to the launching program. If the editor text and/or capture buffer 
has not been saved, you will be asked if you want to save the text before quitting.
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Edit Menu

Undo

Shortcut:  Z

Undo is not used in Spectrum, but is available for use by desk accessories.

Cut

Shortcut:  X

When the editor window is frontmost, choose Cut to cut the highlighted text and save it on the system clipboard.

Copy

Shortcut:  C

When any window is frontmost, choose Copy to copy the highlighted text to the system clipboard.

Paste

Shortcut:  V

When the editor window is frontmost, choose Paste to paste the text stored on the system clipboard at the text 
insertion point. If text is highlighted, the pasted text will replace the highlighted text. NOTE: When the online 
display is frontmost choosing Paste is the same as choosing Send Clipboard To Modem.

Clear

When the editor window is frontmost, choose Clear to delete the highlighted text without placing it on the system 
clipboard (text removed in this manner cannot be pasted later). NOTE: When text is highlighted, pressing Delete 
on the keyboard is just like choosing Clear from the Edit menu.

Select All

Shortcut:  A

When any window is frontmost, choose Select All to highlight all the text in the window.

Paste as Reply

Shortcut:  ' (single quote)

While in the editor, choose Paste as Reply to format and paste the clipboard contents as a reply. This useful if 
you are replying to a message and wish to quote some of the original text. TIP: Highlight text and press C then 

' to quickly convert the highlighted text into reply format.
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For example, if you receive this letter:
Chris,
When does your upcoming vacation end?
--Pat

You could copy the question, start a new document, then press ' and type your response:
>> Chris,
>> When does your upcoming vacation end?
I'll be back in the office next Wednesday!

Send Clipboard To Modem / Send Selection To Modem

Shortcut:  M

Choose Send Clipboard To Modem to send the text stored on the system clipboard to the modem, just as if 
you had typed the text.

If you highlight some text in the editor, capture buffer, or scrollback window this menu item changes to say Send 
Selection To Modem, and choosing it will send just the highlighted text to the modem, just as if you had typed 
the text.

Append Selection To Editor

Shortcut:  ; (semicolon)

If you highlight some text in the editor, capture buffer, or scrollback window you can choose Append Selection To 
Editor to append the highlighted text onto the end of the editor document. TIP: You can append the selection 
using the “reply” format (see “Paste As Reply” above), by holding down the Shift key before choosing Append 
Selection To Editor.

Choose Font

Shortcut:  Y

Select Choose Font to change the font, size, or style of text used in Spectrum.

When no window is open, changing the font sets the default font that is used in the editor, capture buffer, 
scrollback, and clipboard windows (normally Spectrum 8; a special font that is available only while Spectrum is 
running).

When the editor window is frontmost, changing the font affects just the highlighted text. If no text is highlighted 
(i.e. the text insertion point is blinking) the new font will appear when you begin typing (unless you move the text 
insertion point before you begin typing).

When the capture buffer, scrollback, or clipboard window is frontmost, changing the font affects the entire 
contents of that window.
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Text Color

Choose Text Color to change to the foreground and/or background color of text used in the editor. NOTE: Color 
only affects the color of the text within the editor—sending the text will only show black and white.

The Text Color dialog box

Choosing colors immediately changes the color of the highlighted text. If no text is highlighted (i.e. the text 
insertion point is blinking) the new color will appear when you begin typing (unless you move the text insertion 
point before you begin typing).

Choose Close from the File menu (or click the close box) when you are finished changing text colors. TIP: Don’t 
close the Text Color window if you want to change colors of different parts of the text. Instead, use the mouse to 
highlight the text and when you release the mouse button the Text Color window will come to the front 
automatically.

Format Text

Shortcut:  K

Choose Format Text to apply special options to the text in the editor. This option is dim unless text is highlighted 
in the window, and the options affect only the highlighted text.

The Format Text dialog box

Attempting to apply some of these options results in a message that says, “Formatting will lose text styles. 
Continue?” If you don’t mind losing things such as font, size, style, and text color then click Yes; otherwise click 
No and format the text manually.

Checking Convert To Low ASCII will convert high ASCII characters (used in some programs) to low ASCII 
characters (the standard keyboard characters) by removing the “high bit.” High ASCII characters appear in the 
editor window as “special” characters like π, ®, ™, and so on.
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Sometimes these characters are meant to be there (e.g. “2πr”) but if you load a file that consists only of these 
special characters, apply this option to convert them to standard keyboard characters.

Checking Remove All Unnecessary Control Characters will remove all control characters except Tabs, 
Carriage Returns, and Line Feeds. If a Backspace character ($08) is removed, the one preceding character is 
also removed.

Checking Change LFs Into CRs changes all Carriage Return/Line Feed combinations into a Carriage Return, 
and changes standalone Line Feed characters into Carriage Return characters.

Checking Remove Extra Spaces replaces two or more consecutive Space characters with only a single Space, 
and removes spaces before a Carriage Return.

The Format popup menu contains the following choices:
•" CRs Into Spaces: Every Return is changed into a Space.
•" Add Line Feeds: Every Return is changed into a Carriage Return/Line Feed combination that is needed 

by some systems.
•" Lines Into Paragraphs: Converts text from line mode (a Return at the end of every line) to paragraph 

mode (a Return only at the end of a paragraph). To preserve the format of most menus received from 
online services, lines shorter than 35 characters are left as single lines.

•" Paragraphs Into Lines: Converts text from paragraph mode (a Return only at the end of a paragraph) to 
line mode (a Return at the end of every line).

The Special popup menu contains the following choices:
•" all lower case: Changes every letter into lower case.
•" ALL UPPER CASE: Changes every letter into upper case.
•" All Proper Names: Capitalizes the first letter of every word.
•" Capitalize Sentences: Capitalizes the first letter of every sentence.
•" Convert Viewdata To Text: If you’ve captured data from a Viewdata system, the actual text in the capture 

buffer contains all the Viewdata formatting codes. Choose this option to strip the Viewdata formatting 
information so only the text remains.

Find/Replace

Shortcut:  F

Choose Find/Replace to find and replace text.

The Find/Replace window

Type the text you want to find in the Find What box. If you want to replace the text, type the new text in the 
Replace With box.

Click Find Next to find the next occurrence of the text you specified. The search begins at the text insertion 
point, or at the end of any highlighted text. When the end of the text is reached you are told that the text was not 
found, and are given the choice to continue checking at the beginning of the text (if you’ve already checked all of 
the text, click No).
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Click Replace to replace the highlighted text with the text you typed in the Replace With box. Clicking Replace 
will replace the text, then automatically click the Find Next button.

Click Replace All to replace all the occurrences of the Find What text to the new text in the Replace With box. If 
you didn’t start replacing from the beginning of the document,when the bottom of the document is reached you 
are asked if you want to continue from the beginning. If so, click Yes, otherwise click No.

Click Cancel, or click the close box, to close the Find/Replace window.

Options

The Case Sensitive option determines whether capitalization of the Find What text is important. When checked, 
searching for “first” would not find “First.”

You can search for control characters by using a caret (^) and the letter of the control character (e.g. look for 
^m to find all Return characters). To search for an actual caret character, use ^^.

Show Menu

Online Display

Shortcut:  G

Choose Online Display to open the online display. Some displays appear on the standard 640 mode graphic 
screen with a menu bar; other displays hide the menu bar and/or display using some other screen mode (e.g. 
320 mode graphic screen, 80 column text screen, etc.).

If you are using an online display that does not provide access to the File menu, press W to close the online 
display and return to the standard desktop. You must return to the desktop whenever you need to access 
the menu bar (e.g. to manually send or receive a file).

Editor

Shortcut:  E

Choose Editor to display Spectrum’s text editor. The full-featured editor supports all the standard IIgs text editing 
features (cut, copy, paste, arrow keys for movement, fonts, sizes, styles, and so on), as well as changing text 
color. The only length limitation is the amount of memory available. NOTE: See the “Choose Font” option for 
information on setting the default font that is used in the editor.

The editor’s contents are constant; when you close the editor window the window is just hidden and the contents 
are preserved. This ability lets you keep text in the editor while you are online; you can make notes in the editor 
or compose a message reply that can be sent using the “Send Editor Text” command.

To save the editor’s contents, choose Save or Save As from the File menu. If an action would clear the editor 
(e.g. choosing New or Open Editor Document from the File menu) you will be asked if you want to save first.

Capture Buffer

Choose Capture Buffer to display the capture buffer window. This menu item is dim if the capture buffer is 
empty.

For more information about the capture buffer, see the “Capture” item in the “File Menu” section.
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Scrollback

Shortcut:  \ (backslash)

Choose Scrollback to display the scrollback window. This menu item is dim if the scrollback buffer is empty.

The scrollback lets you review the last xK of information that was received recently. It is different from the 
capture buffer in three important ways:

•" It always accumulates text (it cannot be turned off, except by changing the scrollback buffer size to 
“None”).

•" It always shows up to the last xK of information (it can only be cleared by quitting Spectrum, or by 
choosing Scrollback from the Show menu, then choosing Clear Scrollback from the File menu).

•" When quitting Spectrum you are not warned if the scrollback buffer has not been saved.

Clipboard

Choose Clipboard to display the clipboard window. The clipboard contains whatever was last cut or copied.

Chat Line

Shortcut:  ` (accent, or the tilde (~) key)

Choose Chat Line to turn the chat line feature on and off. NOTE: Some online displays do not support a chat 
line.

When a chat line is supported, the screen is divided into two sections: the top of the screen displays incoming 
data, and a small area at the bottom of the screen is used for composing a line of text.

Regular text you type into the chat line is not transmitted to the host until you press Return. Most control 
characters (all except ^H and ^X) are transmitted immediately. NOTE: ^H is like pressing the Delete key (it 
backspaces one letter); ^X is like pressing Clear on the numeric keypad (it erases all the text in the chat line). If 
the chat line is empty, pressing ^X will be transmitted immediately.

The chat line is useful during online conferences or when “chatting” with another system because incoming data 
is displayed in a separate area. Without a chat line, incoming data would be intermixed with what you are typing. 
It is also useful when learning a script, or when line noise interrupts your typing (you can type without regard for 
any incoming “garbage” characters).

You can Paste ( V) text from the clipboard into the chat line, and you can “play” FKeys ( #) into the chat line. 
Scripts that display or transmit information can be run, but that information bypasses the chat line.

Status Line

Shortcut:  Spacebar

Choose Status Line to turn the status line feature on and off. NOTE: Some online displays do not support a 
status line.
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Phone Menu

Dial Number

Shortcut:  D

The Dial Number dialog box

Choose Dial Number to dial a number or create phonebook entries of the systems you call.

Phonebook Entries

Click New to create a new phonebook entry; to edit an existing entry highlight it then click Edit.

The Add/Edit Phonebook Entry dialog box
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Up to 32 phonebook entries can be created. Each phonebook entry remembers everything you need to connect 
to a system: its name, number, port settings, and redial options. Because a specific online display is not required 
in order to connect to a system it is not remembered, however a logon script can open the appropriate display.

Each entry can also remember the name of a script to run after making a connection. Note that only the name 
of the script is remembered—its location is not! In order for the proper script to be run, a menu file must 
have been loaded from the proper folder before dialing (loading a menu file establishes the location from which 
the logon script will be run). For example, imagine you have these two folders:

Both your CompuServe and GEnie phonebook entries indicate that the “Logon” script should be run after 
connection. Before dialing CompuServe, load the menu file from the CompuServe folder. Likewise, before 
dialing GEnie load the menu file from the GEnie folder.

Initialize Modem Before Dialing

This checkbox determines whether the “modem init string” is sent to the modem before dialing. The modem init 
string is a series of commands which prepare the modem for dialing.

After the modem has been initialized, it will not need to be re-initialized for the rest of the session (unless the 
modem is turned off or reset). Therefore, at program startup the “Initialize Modem Before Dialing” option is 
automatically checked, and after the modem initialization string has been sent successfully the option is 
automatically unchecked.

To change the modem init string, click the “Set” button. NOTE: The default modem init string is satisfactory for 
most situations; do not change it unless you have identified a special need (e.g. to instruct the modem to use 
hardware handshaking).

The Set Modem Initialization String dialog box

There are two default modem init strings. The “Standard” init string is “ATZ√ATE0V1Q0 S7=45” which does the 
following:

AT" Gets the modem’s attention (begins all modem commands).
Z" Tells the modem to restore its default settings.
√" This special character (entered by typing Control-R) is not a modem command—it instructs Spectrum to send a 

Return character then wait up to 5 seconds for the modem to respond “OK.”
AT" Gets the modem’s attention (begins all modem commands).
EØ" Tells the modem not to echo commands that Spectrum sends.
V1" Tells the modem to respond using “Hayes verbal result codes.”
QØ" Tells the modem to send its result codes.
S7=45" Tells the modem to wait up to 45 seconds for carrier detect.

CompuServe:
Logon
Menu.File
…other CIS scripts…

GEnie:
Logon
Menu.File
…other GEnie scripts…
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The “High Speed” init string adds “&K3&D0\N3%C0&C1” to the Standard init. Those commands do the 
following:

&K3" Tells the modem to enable hardware flow control.
&D0" Tells the modem to ignore the DTR signal.
\N3" Tells the modem to establish an “auto reliable” connection (a high end modem typically tries to establish a v.

42bis connection, then v.42, then MNP, etc.).
%C0" Tells the modem to disable data compression (when sending files that have already been compressed, data 

compression in the modem can slow down the transfer).
&C1" Tells the modem to make the DCD line reflect the true online state.

After sending the complete modem init string, Spectrum sends a Return character then waits up to 5 seconds for 
the modem to respond “OK.” If the modem does not respond then a “modem not responding” message is 
displayed, otherwise a “Dialing” message is displayed and the phone number entry is sent.

Dialing

To dial a phonebook entry, highlight it and click the Dial button. As a shortcut you can double-click the entry.

To manually dial a system, type the number in the Dial box, change the Port Settings and Redial Options if 
necessary, then click Dial. TIP: If an existing phonebook entry has the port settings and redial options you need, 
click on the phonebook entry. When you do, the entry’s options are displayed. You can then change the phone 
number and click Dial.

A dialog box provides information as Spectrum dials the number and waits for a connection.

Hangup

Shortcut:  H

Choose Hangup to hang up the modem. If the “DCD Is Valid” option is checked in the port settings dialog box, 
and DCD is already false, then no hangup is done. Otherwise Spectrum asks if you are sure you want to hang 
up.

The Hangup dialog box

Click Yes and the modem will be hung up. NOTE: If the Hangup option is dim but the modem is not hung up, 
uncheck the “DCD Is Valid” option in the Port Settings dialog box, then try again.

Send Break

Shortcut:  B

Choose Send Break to send a break signal to the host. A break is not a character that can be output or typed at 
the keyboard; it is a special signal supported by most modems.

The break signal is sometimes called an “attention” signal. Some hosts use Control-C to mean “attention,” and 
some provide a way for you to define what the “attention” signal is (either a true “break” or some character that 
can be typed at the keyboard). Use the Send Break command if the host you are connected to requires a true 
“break” signal.
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Start Timer / Stop Timer

Shortcut:  , (comma)

Choose Start Timer or Stop Timer to start and stop the online timer. The timer is cleared and started 
automatically when you connect to a system when using the “Dial Number” option on the Phone menu. The 
timer is stopped automatically after choosing “Hangup” from the Phone menu.

Clear Timer

Choose Clear Timer to reset the online timer to 00:00:00. Clearing the timer does not turn the timer on or off; 
see Start Timer / Stop Timer.

Answer Back

Choose Answer Back to run a script named Spectrum.Host, located in the Spectrum.Script folder. If 
Spectrum.Host is not found then a dialog box appears from which you can select a script to run (just as if you 
had chosen Run A Script from the Script menu).

Answer Back is merely a quick way to run the Spectrum.Host script; it does nothing more. The Spectrum.Host 
script normally would be a script to answer the modem or run a bulletin board, but it could be anything you like. 
A simple Spectrum.Host script is provided with Spectrum.
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Script Menu

Learn A Script

Shortcut:  L

Choose Learn A Script to record almost any series of steps you do with Spectrum. This option is commonly used 
to learn a logon script, but it can be used to learn other tasks such as reading mail, changing online display 
settings, and so on.

Choose Learn A Script just before you want Spectrum to start remembering the things you do. Specify the name 
and location for the learned script, then click Save. After clicking Save, nearly everything you do will be 
remembered in the script file.

For example, you might choose Dial Number then dial a phonebook entry named “Local BBS.” After the 
connection is made you log into the system just as you always have. You might even respond to options the 
system gives you.

When you are done learning the script, choose Learn A Script again, which removes the checkmark and saves 
the script file. If you followed the example above, the script file might look something like this:

Dial Service "Local BBS"
WaitFor String "Name?"
Transmit "Chris Smith^M"
WaitFor String "Password?"
Transmit "SecretWord^M"
WaitFor String "choice:"
Transmit "R^M"

To repeat the steps you learned, just run the script. In the example above, Spectrum will dial a phonebook entry 
named “Local BBS” and after the connection is made it will log into the system and respond to an option the 
system provides.

Learning a script is not limited to just logon steps. For example, if you turn on the chat line that step will be 
recorded; if you start, stop, or clear the timer those steps will be recorded; if you change some online display 
options that will be recorded; and so on.

Learned scripts can perform many tasks (for example, change the port to 2400 baud, open the Spectrum Text 
display, set the file transfer directory to a certain location, load a menu file from another location, log onto a 
system, turn the chat line on, and so on).

Limitations Of Learned Scripts

Spectrum cannot automatically learn how to do things conditionally (e.g. only read the mail if there is mail 
waiting).

Line noise can interfere with a learned script because Spectrum learns every incoming character. For example, 
if a system sends a message “What is your password?” but line noise interferes, Spectrum might learn to wait 
for a string called “passw@r#d?”. The next time you log on, “passw@r#d” would not be seen, so the script would 
not proceed.

Character echo and duplex can cause “odd” statements to be recorded into the script. For example, you type 
“Secret” but the script records:

Transmit "Sec"
WaitFor String "Sec"
Transmit "ret^M"



Script Menu 
 38

These limitations can be overcome by editing the script. For example, to clear up the line noise problem you just 
have to change the “WaitFor String” command to wait for the proper word. TIP: Turning on the Chat Line before 
learning the script can also help.

To learn about writing and editing scripts, refer to the Spectrum Scripting manual. Don’t be intimidated by 
the size of the scripting manual…it indicates the robustness of Spectrum’s script commands, not the complexity!

Run A Script

Shortcut:  R

Choose Run A Script to run a script. A dialog box appears in which you can select the script to run. This dialog 
box always initially shows the folder from which the menu file was loaded (or the Spectrum.Script folder if no 
menu file has been loaded).

Spectrum loads the selected file into memory and begins interpreting the information in that file. If the file 
contains valid script commands then Spectrum carries out those commands. If an unrecognized command is 
encountered, Spectrum stops and displays an error message. While a script is running, a black box appears at 
the upper-right corner of the menu bar.

When a script is running, the Run A Script menu item changes to become “Stop Script.” To stop a script choose 
Stop Script from the Script menu, or press Escape. NOTE: Some script commands temporarily block the use of 
the menu bar; if one method does not work, try another.

Rerun Script In Memory

Shortcut:  * (asterisk)

To rerun the last script that was run, choose Rerun Script In Memory. Choosing this command when a script is 
already running will restart the script from the beginning.

Run Editor As Script

Shortcut:  – (dash)

Choose Run Editor As Script to run the current contents of the editor as a script. This command is very useful 
when writing or modifying a script because after loading a script into the editor you can make modifications, run 
the editor as a script, make more changes, run the editor as a script, and so on. That development cycle is much 
faster than having to save the editor to disk before it can be run.

Load Menu File

Choose Load Menu File to load a text file of script descriptions to be appended to the Script menu.

Loading a menu file serves two important purposes. First, it determines which folder is initially displayed when 
you choose Run A Script. This feature lets you store groups of related scripts in separate folders. For example, 
all the scripts you use for CompuServe can be stored in a “CompuServe” folder, and all the scripts for GEnie can 
be stored in a “GEnie” folder.

When you want to use the CompuServe scripts you would load a menu file located in the CompuServe folder. 
From then on, choosing Run A Script will initially show you the scripts in that folder. Likewise, when you want to 
use the GEnie scripts you would load a menu file located in the GEnie folder.
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Second, it provides a way for you to run scripts simply by choosing them from the Script menu (completely 
bypassing the Run A Script dialog box). For example, a menu file might contain the following text:

C CompuServe Menu
G GEnie Menu

When that menu file is loaded, the Script menu will look like this:

The natural question is, “How does Spectrum know which script to run 
when a particular menu item is chosen?” The answer has to do with the 
letter that is shown on the menu.

When you choose “C CompuServe Menu” from the Script menu, 
Spectrum attempts to run a script named “C”. If Spectrum cannot find a 
script named “C” it then searches for a script that begins with “C.” (C 
period). The first match it finds will be run (nothing happens if the script 
is not found). REMEMBER: Spectrum looks in the folder that the menu 
file was loaded from.

Therefore, you can name the file “C” or “C.CIS.Menu” or “C.anything” and it will be run when you choose 
“C CompuServe Menu” from the Script menu (provided it is stored in the same folder as the menu file that was 
last loaded).

Thanks to this script file naming convention, you also have the ability to run scripts directly from the keyboard! 
The  symbol on the menu indicates the Option key on the keyboard. That means pressing C (that’s Option-C, 
not C which is Command-C) will run the script named “C” (or “C.anything”)! NOTE: In order for this to work, 
the “Recognize  script keys” option must be checked in the Online Display Settings dialog box.

Menu File Format

Although a menu file can be named anything on disk, the contents of the menu file is special: Each menu item 
must be listed on a separate line, in the order you want them to appear. For each menu item, type the letter of 
the script, press the Spacebar, then type the name of the item as you want it to appear on the Script menu, then 
press Return. For example,

A About these scripts
L Logon
M Check Mail
F Find a user

When loading a menu file, take care to only load text files that follow this format (loading your shopping list will 
produce odd results at the end of the Script menu).

A menu file can list none, some, or all the scripts available in a folder. In fact, a menu file can even list scripts 
that don’t actually exist. As far as Spectrum is concerned, a menu file is simply a list of letters with descriptions 
to add to the end of the Script menu.

Loading an empty menu file removes the menu file entries from the Script menu, and establishes the folder that 
Spectrum looks in when SomeLetter is pressed.

Clear Menu File

Choose Clear Menu File to remove all entries listed below this menu item, and to reset the scripts folder back to 
“Spectrum.Script” in the same folder as the Spectrum application.

The Script menu with a menu file loaded
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Settings Menu

Port

Choose Port from the Settings menu to change the communications port and its settings.

The Port Settings dialog box

Baud Rate: The baud rate is the speed at which the communications port talks to the modem (it is not 
necessarily the same speed at which the modem talks to the host). The “Default” choice uses the baud rate 
specified in the Control Panel (if Printer Port is selected then the printer port’s baud rate is used; if Modem Port 
or any slot number is selected then the modem port’s baud rate is used).

Data Format: The data format consists of a number of data bits, parity, and stop bits. For completeness there 
are many possible combinations that can be selected. In practice, however, you will probably use only the “8 
bits, no parity, 1 stop bit” option.
Data bits indicates the size of each character in a transmission. Parity is an old form of error checking that is 
seldom used today. Stop bits signal that a character has been transmitted. The commonly-used “8-None-1” 
option recognizes most hosts, and it must be used in order to use any of the file transfer protocols. It even 
recognizes hosts who are sending to you using a 7-Even-2 data format, although you may end up with 
unreadable “high ASCII” characters on the screen (if this happens, check the “Convert To Low ASCII” option in 
the Online Display Settings dialog box to fix the characters as they are received).

Buffer Size: This option determines the size of Spectrum’s internal port buffer. All incoming data is seen by a 
special “port driver” which quickly places any incoming characters into the port buffer (this occurs even when 
you’re using Spectrum for other things, such as typing in the editor). The larger this buffer, the more data can be 
received before the port driver must tell the host to stop sending data.
A 2K buffer is usually sufficient, but if you communicate at a high baud rate (9,600 or higher), or if you have 
spare memory you don’t mind using, consider increasing the port buffer size.

Half Duplex: When checked, outgoing data is sent to the port and the online display; when not checked 
(meaning full duplex) outgoing data is sent only to the port and characters will appear on the screen only if the 
host echos them back to Spectrum.
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Echo: When checked, incoming data is sent back out the port as it is processed. Echo is sometimes used when 
you are acting like a bulletin board or you connect with other Spectrum users. In this case, one end becomes the 
host. The host would have Half Duplex and Echo on, and the other end would use full duplex. NOTE: If Echo is 
on and the host echoes characters back to you, you may find yourself in a loop with the same characters 
constantly being echoed between the two systems. Turn echo off to stop the loop.

Send LFs: When typing, pasting text, or sending a text file, this option appends a line feed character after each 
Return character. Line feeds are commonly used in the MS-DOS world; they are usually not required for Apple 
systems.
TIP: Leave this option off if you only need line feeds occasionally. When you need to send a text file with line 
feeds, open the file in the editor, choose Format Text from the Edit menu, apply the “Add Line Feeds” formatting 
option, then send the editor text.

H’ware Handshake: If your modem supports hardware handshaking, and you have a properly-wired modem 
cable (see Appendix A for cabling information) then check this option to use hardware handshaking to control the 
flow of data between your computer and modem.
NOTE: You may have to add commands to your “Modem Init” to instruct your modem to use hardware 
handshaking. For example, the SupraFAXModem requires the &K3 command to enable hardware flow control.

Xon/Xoff Flow: This option determines if Spectrum’s port driver uses and recognizes Xon/Xoff characters to 
control the flow of data between your computer and the host. If the receiver can’t keep up with the incoming data 
it tells the sender to wait. When the receiver is ready for more information it tells the sender to continue.
Xon/Xoff “software flow control” applies only to text transfers, and when you are receiving text to the online 
display. It is not used during file transfer protocols (e.g. Xmodem) because those protocols use their own form of 
software flow control.

Character Delay: When typing, pasting text, or sending a text file, this option determines the delay after each 
character is sent out the port. The value is in 1/60ths of a second (0 is no delay, 9 is a .15 second delay):

NOTE: Most hosts do not require a delay, but try increasing the character delay if a host has trouble recognizing 
commands sent from a script.

Line Delay: When typing, pasting text, or sending a text file, this option determines the delay after a Return 
character is sent out the port. The value is in 16/60ths of a second (0 is no delay; 9 is a 2.4 second delay):

Value Calculation Seconds Value Calculation Seconds

0 0*1/60 0 5 5*1/60 0.08

1 1*1/60 0.02 6 6*1/60 0.10

2 2*1/60 0.03 7 7*1/60 0.12

3 3*1/60 0.05 8 8*1/60 0.13

4 4*1/60 0.07 9 9*1/60 0.15

Value Calculation Seconds Value Calculation Seconds

0 0*16/60 0 5 5*16/60 1.33

1 1*16/60 0.27 6 6*16/60 1.60

2 2*16/60 0.53 7 7*16/60 1.87

3 3*16/60 0.80 8 8*16/60 2.13

4 4*16/60 1.07 9 9*16/60 2.40
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NOTE: Most hosts do not require a delay, but if a host has trouble accepting your text file uploads, try increasing 
the line and/or character delays until you reach a speed the host can handle.

DCD Is Valid: DCD stands for “Data Carrier Detect.” If your modem properly controls the DCD signal, and you 
have a properly-wired modem cable (see Appendix A for cabling information) then check this option so Spectrum 
will know it can rely on the DCD signal to determine if you are connected to a remote system.
NOTE: You may have to add commands to your “Modem Init” to instruct your modem to properly control the 
DCD signal. For example, the SupraFAXModem requires the &C1 command before it will indicate whether a 
remote modem’s data carrier tone is present.

Printer Port/Modem Port/Your Card In Slot: If your modem is connected to one of the ports on the back of the 
IIgs, select the appropriate port. If your modem is connected to a Super Serial Card (or workalike) or to the AE 
DataLink modem (or workalike) then select the slot number. When you click OK the port/slot is checked and an 
error is displayed if the choice is not valid.

Online Display

Choose Online Display from the Settings menu to select an online display and change settings that affect them.

The Online Display Settings dialog box

The “Spectrum SHR Fast,” “Spectrum SHR Normal,” and “Spectrum Text” displays are built-in to Spectrum and 
are always available. Additional displays can be added by dropping them into Spectrum’s “Add.Ons” folder 
(complete information for each online display can be found on disk in Spectrum’s “Documentation” folder).

Capture Buffer Size: Use this popup menu to adjust the size of the capture buffer. Storing data into the capture 
buffer can be turned on and off by choosing Capture on the File menu. When the capture buffer fills to the 
specified size, Spectrum prompts you to save the capture buffer, clears it, then starts over. If the capture buffer 
size is set to None then no data will be stored in the capture buffer.

Scrollback Buffer Size: Use this popup menu to adjust the size of the scrollback buffer. The scrollback buffer is 
always active (the only way to turn it off is to set the scrollback buffer size to None). It remembers the last xK of 
information that was sent or received (it is a “true” record of incoming and outgoing text).
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Use Online Display’s Editor: Although the three built-in online displays do not include a special editor, other 
online displays might. By checking this option, the online display’s custom editor (if one exists) will be used, 
otherwise Spectrum’s built-in text editor will be used.

Delete Key = Backspace: When this option is checked, pressing the Delete key while typing in an online 
display will transmit the backspace character ($08, ^H, left arrow) instead of the delete character ($7F). Most 
hosts expect a backspace, so this option should normally be checked.

Auto Buffer Control: When checked, Spectrum watches for ^R and ^T character so it can track whether the 
host wants the capture buffer on or off (some hosts use those characters to control the downloading of text 
data). However, Spectrum will not honor the host’s request unless the Capture option (on the File menu) is not 
checked. That is, if you want data to be captured it definitely will be; the host can control the capture status only 
if you have turned off the Capture option.

Convert To Low ASCII: When checked, the high bit of incoming data is removed in order to bring each 
character into the range of “normal” displayable characters. NOTE: Some online displays (e.g. ANSI) require full 
8-bit characters so they might override this setting.
If you connect to a regular text-based system such as GEnie, this option should be checked in order to avoid 
seeing strange characters. However, if the host supports full 8-bit characters you can uncheck this option when 
you want to send a text file that contains foreign language or other “special” characters like curly quotes, π 
symbols, and so on.

Recognize  Script Keys: When checked and an online display is frontmost, pressing A (option-A) will 
attempt to run a script named A or A.anything (see the “Run a Script” section for more information). If the online 
display is closed you can run scripts only by using the Script menu.
If you want to type option characters (e.g. π, ©, ®) into an online display, close the online display (if open), then 
uncheck this option and the “Convert To Low ASCII” option. NOTE: The “Translation” option (in the General 
Control Panel) must be set to something other than “None.”

Clock: Check this option to display a clock in the menu bar (and in the status bar of some online displays).

Sounds: Determines whether various Spectrum sounds are played (e.g. “Welcome to Spectrum,” “Goodbye,” 
and so on).

Clicks: Determines whether keyboard sounds are played while typing in an online display. NOTE: Turn off this 
option if you type very fast.
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…More Display Options

Choose More Display Options from the Settings menu to change options that apply only to the current online 
display.

This menu item is usually dim because most online displays do not have special preferences; if the online 
display you are using does have special preferences, this menu item will be activated. Complete documentation 
for each online display can be found in the “Documentation” folder.

Character Filter

Choose Character Filter from the Settings menu to choose or create special keyboard and display filters. Filters 
are used to translate one character into another, or to completely remove a character.

The Character Filter Settings dialog box

No filtering occurs during non-text protocol transfers (CIS B+, Xmodem, etc.). At all other times filtering does 
occur.

The Keyboard filter applies to outgoing text (typing in an online display, pasting text to the modem, sending a 
text file, and the Transmit script command). NOTE: If the “Echo” option is checked in the Port Settings dialog 
box, text from the Display and DisplayRecord script commands is also run through the Keyboard filter.

The Display filter applies to incoming text.

The “Default” filter means the General CDEV’s translation setting will be used. To add a new table, or to edit one 
that was previously added, click the Filter Editor button.

The Filter Editor dialog box
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Click Add Table to add a new table. New tables always pass every character except character $00, which is 
always stopped.

To edit, delete, or reset a table, choose the desired table from the popup menu in the upper right of the dialog 
box. Click Delete Table to delete the table, or click Reset Table to reset it to the default values (pass everything 
except $00).

To edit the table, select a character then type the desired translation in the edit box. If the desired character is a 
regular letter available on the keyboard you can type the character, otherwise you can use ^letter to indicate 
control characters, or the hexadecimal number ($# or $##). Finally, click the Translate button. For example:

•" To translate the letter A into the letter Z, highlight “$41 A Pass,” type Z (or $5A), then click the Translate 
button.

•" To completely strip the letter A, highlight “$41 A,” type $0, then click the Translate button.
•" To pass the letter A as-is (no translation), highlight “$41 A,” type A (or $41), then click the Translate 

button.

File Transfer

Choose File Transfer from the Settings menu to select a folder for automatic file transfers and to set other file 
send/receive options. NOTE: If possible, you should always receive files to a hard drive or RAM disk.

A portion of the File Transfer Settings dialog box

Resume Transfers: When this option is checked, Spectrum does not delete partially-received files if the file 
transfer protocol supports resuming transfers (e.g. CompuServe B+, Zmodem). If you later start receiving the 
same filename to the same folder (using the same file transfer protocol), Spectrum will continue transferring the 
file from the point the transfer was aborted. NOTE: This works only if the “Binary II Down” option is not checked.
For example, you begin receiving a huge file via Zmodem protocol and 95% of the file is transferred when the 
host suddenly disconnects. If this option is not checked, the partial file is deleted and you’ll have to transfer the 
entire file again. But if Resume Transfers is checked (and you were not using Binary II Down) then only the 
remaining 5% will have to be transferred.

Auto Receive: When checked, Spectrum watches for special characters that indicate the host wants to send a 
file (typically in response to your request that a file be sent). If Spectrum sees the required characters it 
automatically begins receiving the file to the specified folder—you do not have to manually choose the 
appropriate protocol from the Receive File sub-menu. NOTE: Auto Receive works only with the CompuServe B+ 
and Zmodem file transfer protocols.
For example, if you instruct CompuServe to send a particular file via the CIS B+ protocol, CompuServe sends a 
^E character. If Auto Receive is checked, Spectrum responds that it is ready to receive and CompuServe sends 
the file. If Auto Receive is not checked, you would have to manually choose CIS B+ from the Receive File sub-
menu in order for Spectrum to respond). NOTE: Because CompuServe’s CIS B+ inquiry command is a simple 
Control-E character, false auto-receives can be triggered by some hosts. If this happens, turn off the Auto 
Receive option for those hosts.
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Packet Send Ahead: Most file transfer protocols operate by sending a “packet” of data, waiting for a “received” 
response, then sending the next packet. When Packet Send Ahead is off, the protocols that work this way 
continue to do so. However, when the option is on, some protocols (e.g. CompuServe B+, Zmodem) can send 
additional packets without waiting for an acknowledgement, which can speed up file transfers.
This option should normally be on, but turn it off if you experience many file transfer errors when using a 
protocol that supports Packet Send Ahead.

Send Text Prompt: This is the character that is checked for when sending a text file using the Prompted option. 
Use the ^Letter character to indicate a control character, or type a hexadecimal number. NOTE: Enter $3A to 
represent a colon (:). Enter ^@ (or $00) to disable the Prompted option.

Binary II Down: If this option is checked, as a file is received it will be examined. If the file has a Binary II 
header, the header will be stripped and the file will be saved with its correct file name, type, and format. See the 
“Transferring Files” section for more information about Binary II.
NOTE: If this option is checked, Resume Transfers will not work. If you are receiving Apple II or IIgs files you 
should leave this option unchecked and use ShrinkIt-GS to remove the Binary II wrapper.

Binary II Up: If this option is checked a Binary II header is added to each file being uploaded (see the 
“Transferring Files” section for more information about Binary II). If the file already has a Binary II header then a 
second one is not added.

ProDOS Xmodem: If this option is checked, Spectrum adds the ProDOS Xmodem extension to any Xmodem 
file transfer. This option only controls sending files; Spectrum automatically detects whether received files have 
the ProDOS Xmodem extension.

Pad Empty Lines: Some hosts use a blank line to indicate the end of a text message. If this option is checked, 
when you send a text file that contains empty lines (lines with only a Return), those empty lines are padded so 
the host actually receives “Space Return”, which prevents the host from thinking the message is finished being 
sent. After a text file has been sent with this option on, you may need to press Return once or twice to tell the 
host the message is complete.

Save Settings

Choose Save Settings to remember all of Spectrum’s current settings. Settings are automatically saved when 
you quit (unless you have checked the “Don’t save setting changes” option in the Status dialog box).

All settings (including your phonebook entries) are stored in the Spectrum.Prefs file, which is located either in 
the *:System:Preferences folder on a standalone computer, or in your AppleShare folder. Delete this preference 
file if you want to restore all the default settings.

Load Settings

Choose Load Settings to restore all the options that were in effect when you last chose Save Settings.
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Status

Choose Status to display information about some current Spectrum settings.

The Status dialog box

The Buffer Used value shows how many characters are currently stored in the capture buffer.

Normally all of Spectrum’s settings are saved automatically when you quit. Click the Don’t Save Setting 
Changes option if you prefer to manually control when settings are saved (by choosing Save Settings).
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Transferring Files
A primary use of modem communications is to transfer files from one computer to another. This section 
discusses various aspects relating to transferring files from one computer to another

General Tips
When receiving files, save to a RAM disk or a hard disk drive. Devices that shut off interrupts for a “long” 
time (e.g. floppy disk drives) can cause lost data if data arrives while disk activity is occurring.
If you must save to a floppy disk drive:

•" turn off the “Packet Send Ahead” file transfer option
•" use protocols that send a packet and wait for an acknowledgement before sending more information (e.g. 

all non-text protocols if the “Packet Send Ahead” option is off)
•" don’t use a protocol that can’t recover from an error (e.g. Ymodem‑g)
•" use hardware handshaking

Do not move the mouse during transfers. Moving the mouse interrupts the computer. This causes the file 
transfer to slow down, and can also cause lost characters (and therefore errors) when receiving a file.

Do not use system extensions that cause or use interrupts. If you have trouble with dropped/missing/lost 
characters when communicating with Spectrum, or file transfers are slower than they should be, be sure to read 
the “Check Your System Extensions” section in this manual.

Use a compression program such as ShrinkIt-GS before sending files. Not only does this decrease the 
transfer time, but it also preserves file information (name, type, dates, etc.).

Do not use “data compression” if your modem supports it. The only possible exception to this is if you are 
using a V.32bis modem and have made a V.42bis connection, in which case the modem’s data compression 
might be faster if you send an uncompressed file.

If you’re using a V.32 (no “bis”) modem or V.42 (no “bis”) connection, or are sending a file that is already 
compressed, then do not use data compression.
When in doubt, experiment to see whether it is faster to send an uncompressed file with the modem’s data 
compression turned on, or faster to send a compressed file with the modem’s data compression turned off.

Remember that phone lines aren’t perfect. The only really clean line is a hardwired link between two 
computers. As soon as a phone network comes into the picture, anything can happen! Most phone connections 
today are clean and reliable, but every so often you’ll get a bad connection with line noise, which can cause 
garbage characters and file transfer errors (especially at high baud rates). When this occurs, hang up and try the 
number again. If the problem still occurs, read the “Check Your System Extensions” section in this manual.
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File Transfer Protocols
Transferring files is accomplished by using a pre-arranged method of communicating—a file transfer “protocol.” 
Spectrum supports a range of common protocols. Which one you use for a particular file depends upon a variety 
of factors, such as:

•" what protocols are supported by the host (if the host only supports Xmodem you cannot send and receive 
using Zmodem)

•" whether you have a good phone line connection (a bad or “noisy” connection can cause errors, and some 
protocols handle errors better than others)

Text

If you are transferring text files, an error here or there is usually not critical (if you see “He{lo” you’d probably 
know the person was saying “Hello”). In cases where accuracy is not critical you can use the “Text” protocol, 
which has no error detection ability. NOTE: Some services call this “no protocol.”

Sending and receiving files via the Text protocol is essentially the same as typing information at the keyboard 
and capturing information as it comes in from the host.

Because it does not support error correction, the Text protocol should be used only in situations where you 
would normally be typing something at the keyboard. For example, you could prepare an electronic mail 
message offline, go online, then post the message by sending it with the Text protocol (which works like you 
were typing the message at the keyboard, only much faster).

Other Protocols

If you are transferring program or data files, errors must be eliminated because every character must match the 
original file exactly, or the file won’t be useable. In cases where accuracy is required, you must use a protocol 
that supports error detection (any protocol except Text).

To transfer a file, all non-text protocols work in a similar way. For example, assume you are receiving a file from 
GEnie. After initiating a transfer, GEnie sends a “packet” of characters to your computer. As it sends the data, 
GEnie calculates a “checksum” based on the characters being sent. As Spectrum receives the data it also 
calculates a checksum (based on the characters it receives).

After a certain number of characters has been sent, GEnie sends the checksum information and Spectrum 
compares its checksum with GEnie’s. If they match then that packet of data is considered valid and the process 
continues until the entire file is transferred.

If the checksums do not match then the protocol determines what happens. Most protocols will tell GEnie to 
send the packet again; some “turbo” protocols simply abort the transfer.
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Knowing which protocol to use can be difficult. Assuming you have a good phone line connection, this table lists 
the protocols in order of speed and desirability (Zmodem being the best):

More information about each protocol is below. In short, use Zmodem or CIS B+ if the host supports it; otherwise 
try Xmodem first, then try the remaining protocols.

Standard Xmodem, 1K Xmodem, 4K Xmodem
(when the “ProDOS Xmodem” checkbox is OFF in the File Transfer Settings dialog box)

Xmodem is the simplest protocol. Basic Xmodem uses packets of 128‑bytes; the 1K and 4K variations use 
1,024‑byte and 4,096‑byte packets, respectively.

Spectrum’s 1K Xmodem and 4K Xmodem options use a technique to vary the packet sizes; too many bad 
packets will decrease the packet size until good packets are received, at which point they will increase.

When a packet is sent, the receiving end responds with an “ACK” (good packet) or a “NAK” (bad packet). If the 
sender gets an “ACK” it sends the next packet, otherwise it retransmits the packet.

Pros:" The most universal protocol—virtually all telecom programs and hosts support Xmodem.

Cons:" Slow transfers. There is much wasted time while waiting for ACKs/NAKs between packets, especially on 
long distance networks. If line noise happens to cause a spurious “good packet” acknowledgement, 
there is no recovery.

" The packet checksum isn’t foolproof. The checksum is only a simple 8 bit calculation, and it is possible 
for a corrupt packet to produce a valid checksum, thus leaving a corrupt file.

" Doesn’t transfer the file’s name or type (must use a Binary II header).

ProDOS Xmodem, 1K Xmodem, 4K Xmodem
(when the “ProDOS Xmodem” checkbox is ON in the File Transfer Settings dialog box)

ProDOS Xmodem was created to resolve Standard Xmodem’s file name and type limitation. ProDOS Xmodem 
is the same as Standard Xmodem above, except a trailing packet is sent that includes the file’s name and 
ProDOS file type.

Protocol
Transfer 

Batch 
of Files

Maximum 
Bytes in 
Packet

Continuous 
Transfer 
Possible

Bad Packets 
Re-sent

Resumes 
Aborted 

Transfers

Xmodem No 128 No Yes No

1K Xmodem No 1,0241 No Yes No

4K Xmodem No 4,0961 No Yes No

Ymodem Yes 4,0961 No Yes No

Ymodem-g Yes 4,0961 Yes No No

CIS B+ No3 1,0241 Yes2 Yes Yes4

Zmodem Yes 1,0241 Yes2 Yes Yes4

1" Starts with small packets and increases/decreases the packet size depending upon how 
successfully the transfer is progressing.

2" Only if the “Packet Send Ahead” option is checked (in the File Transfer Settings dialog 
box).

3" Theoretically possible, but in practice CompuServe never does batch file transfers.
4" Only if the “Resume Transfers” option is checked and the “Binary II Down” option is not 

checked (in the File Transfer Settings dialog box).

1" Starts with small packets and increases/decreases the packet size depending upon how 
successfully the transfer is progressing.

2" Only if the “Packet Send Ahead” option is checked (in the File Transfer Settings dialog 
box).

3" Theoretically possible, but in practice CompuServe never does batch file transfers.
4" Only if the “Resume Transfers” option is checked and the “Binary II Down” option is not 

checked (in the File Transfer Settings dialog box).

1" Starts with small packets and increases/decreases the packet size depending upon how 
successfully the transfer is progressing.

2" Only if the “Packet Send Ahead” option is checked (in the File Transfer Settings dialog 
box).

3" Theoretically possible, but in practice CompuServe never does batch file transfers.
4" Only if the “Resume Transfers” option is checked and the “Binary II Down” option is not 

checked (in the File Transfer Settings dialog box).

1" Starts with small packets and increases/decreases the packet size depending upon how 
successfully the transfer is progressing.

2" Only if the “Packet Send Ahead” option is checked (in the File Transfer Settings dialog 
box).

3" Theoretically possible, but in practice CompuServe never does batch file transfers.
4" Only if the “Resume Transfers” option is checked and the “Binary II Down” option is not 

checked (in the File Transfer Settings dialog box).

1" Starts with small packets and increases/decreases the packet size depending upon how 
successfully the transfer is progressing.

2" Only if the “Packet Send Ahead” option is checked (in the File Transfer Settings dialog 
box).

3" Theoretically possible, but in practice CompuServe never does batch file transfers.
4" Only if the “Resume Transfers” option is checked and the “Binary II Down” option is not 

checked (in the File Transfer Settings dialog box).

1" Starts with small packets and increases/decreases the packet size depending upon how 
successfully the transfer is progressing.

2" Only if the “Packet Send Ahead” option is checked (in the File Transfer Settings dialog 
box).

3" Theoretically possible, but in practice CompuServe never does batch file transfers.
4" Only if the “Resume Transfers” option is checked and the “Binary II Down” option is not 

checked (in the File Transfer Settings dialog box).
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Pros:" Based on Standard Xmodem (it doesn’t hurt to always use ProDOS Xmodem; systems that don’t 
support it will ignore the extra information).

Cons:" Only Apple II bulletin boards support it.
" Slow transfers.
" The packet checksum isn’t foolproof.

Ymodem Batch

Ymodem is similar to Xmodem, except it transfers the file’s name before sending a file (no file type though). 
Ymodem also supports sending a “batch” of files (files are sent one after another, and an empty file name 
indicates the end of the transfer).

Spectrum’s Ymodem options use a technique to vary the packet sizes; too many bad packets will decrease the 
packet size until good packets are received, at which point they will increase. Ymodem Batch and Ymodem‑g 
can handle packet sizes up to 4,096‑bytes if the receiver responds to an initial interrogation.

There is also an optional (though most hosts support it) 16‑bit CRC packet checksum. The CRC (Cyclic 
Redundancy Check) provides very good packet integrity.

Pros:" Supports batch file transfers.
" Very good packet checksum (16‑bit CRC).
" Supported by most telecom programs and hosts.

Cons:" Slow transfers (works the same as Xmodem).
" Doesn’t transfer the file’s type (must use a Binary II header; there is no “ProDOS Ymodem”).

Ymodem-g

Ymodem-g works like Ymodem except that the sender does not wait for an “ACK” acknowledgment before 
sending the next packet.

Pros:" If you have a good connection and a very fast disk device (e.g. RAM Disk), it is faster than Zmodem 
(less packet overhead).

Cons:" One bad packet aborts the transfer (because the sender isn’t waiting for ACKs). This can happen 
through line noise, an interrupt while writing to disk, and so on.

CIS B+

CIS B+ (CompuServe B+) uses packets between 512‑bytes and 1,024‑bytes in size; at the start of a transfer 
there is an exchange of parameters to initiate the transfer.

If the “Packet Send Ahead” option is on in the File Transfer Settings dialog box, CIS B+ will send two packets 
when it begins sending a file. When the receiver ACKs the first packet, the sender transmits the third packet, 
and so on (no more than two packets are ever sent ahead). With a maximum network delay of around 1.5 
seconds to most parts of the world, this gives an almost continuous transfer (which reduces the transfer time).

It supports the “Resume Transfers” option, which allows interrupted transfers to resume where they left off.

It supports the “Auto Receive” option, which allows files to be received automatically (you don’t have to manually 
choose CIS B+ from the Receive File sub-menu).

Pros:" Improved transfer speeds when the “Packet Send Ahead” option is on in the File Transfer dialog box.
" Very good packet checksum (16‑bit CRC).
" The file’s name is transmitted.
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" Files can be received automatically.
" Good error recovery—partial transfers can be resumed.

Cons:" Only supported by CompuServe.
" CompuServe directs file sending and receiving—you cannot use CIS B+ protocol with another Spectrum 

user.
" No ProDOS file type information is sent (just a “text” or “binary” indicator); must use a Binary II header.
" The “auto receive” character is a simple Control‑E; false file receives can be triggered by spurious 

Control‑E characters.

Zmodem

Zmodem is the “Rolls Royce” of file transfer protocols. Zmodem uses “dynamic” packet sizes that vary from 
128‑bytes to 1,024‑bytes in size. If too many bad packets are received, the packet size decreases until good 
packets are transmitted. When good packets are achieved the packet size increases.

There is an optional (though most hosts support it) 32‑bit CRC checksum which provides nearly bulletproof 
protection against bad packets.

If the “Packet Send Ahead” option is on in the File Transfer Settings dialog box, Zmodem won’t wait for a “good 
packet” acknowledgment. Instead, it sends a continuous stream of packets until the receiver reports “bad 
packet.” If that occurs, the sender restarts with that packet and resumes sending a continuous stream of 
packets.

It supports the “resume transfers” option, which allows interrupted transfers to resume where they left off.

It supports the “Auto Receive” option, which allows files to be received automatically (you don’t have to manually 
choose Zmodem from the Receive File sub-menu).

Pros:" Uses 16‑bit or 32‑bit CRC packet checksum, which provides “very good” to “near bulletproof” packet 
verification.

" Good error recovery—partial transfers can be resumed.
" Supports batch file transfers.
" The file’s name is transmitted.
" Files can be received automatically.

Cons:" Not many hosts support it for sending and receiving files.
" No ProDOS file type information is sent; must use a Binary II header.

Binary II Headers
When sending a file from one Apple II to another, the ProDOS Xmodem format works to preserve file information 
such as the file’s name, type, and so on. But what if you want to use a file transfer protocol other than Xmodem? 
To preserve file information in these situations, a special “header” can be added which describes the file.

Some compression programs (e.g. ShrinkIt-GS) have an option to add a “Binary II” header, and Spectrum also 
provides this option. In general, Spectrum’s “Binary II Up” option should be turned on. If a file doesn’t already 
have a Binary II header, one will be added as the file is sent.

When it receives a file, Spectrum can remove a Binary II header and use the information it contains to create a 
file with the proper name, type, etc. However, with “Binary II Down” turned on, file transfers cannot be resumed if 
they are interrupted. This, coupled with the fact that ShrinkIt‑GS can automatically remove Binary II headers, 
suggests that the Binary II Down option should normally be turned off.
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Other Information
This section covers various other information that is important or interesting, but that didn’t fit anywhere else.

The Startup Process
The following things occur when Spectrum is launched (not necessarily in this order):

•" Spectrum verifies all its required files are available (e.g. the Hierarchic INIT, the Spectrum.Port driver, 
etc.). If the Hierarchic INIT is not active (for example, if you Shift-booted the computer) then Spectrum will 
ask if you want to load it.

•" Spectrum checks the port setting to verify it is valid. If it isn’t (e.g. slot 2 was specified but there is no 
longer a serial card in slot 2) then the Port Settings dialog box appears so a valid port can be selected. 
You can click Cancel to quit Spectrum.

•" At the conclusion of the startup process Spectrum checks the message center to see if there is a 
document to process (could occur if TransProg III, CoPilot, or some other application launched 
Spectrum). If so, the document is run as a script.

" If there is no document, Spectrum attempts to run a script named “Spectrum.Start” (in the 
Spectrum.Script folder in the same folder as Spectrum). If no script is found then the startup process is 
finished.

" If you want Spectrum to do certain things every time it starts (e.g. you want it to load a particular menu 
file then run a particular script) you can change the supplied Spectrum.Start as necessary. TIP: When 
Spectrum is updated a new Spectrum.Start script might be provided. To avoid losing your changes it is 
recommended that you write a separate script that contains your startup procedures, and just include a 
“Run Script” statement within Spectrum.Start.

General Keys
The following special keys are available while using Spectrum:

"Shift- 3" Saves the screen image to a disk file in the folder that was last accessed. If a graphic screen is 
displayed then a standard picture file is created. If a text screen is displayed then a text file is created.

"Shift- 4" If the Caps Lock key is up, prints a screen image of the active window.

" " If the Caps Lock key is down, prints a screen image of the entire screen.

"  Clear" Resets the serial port. If incoming data stops flowing and the host seems to “hang,” first try pressing 
Control-Q (not Q) because the host just might be waiting for an “Xon” character. If that doesn’t work, 
press Clear (or –Control–X) to reset the serial port.

Using Twilight II
NOTE: It has been reported that using Twilight II causes character loss at high speeds. If you are using high 
speed connections and lose data, inactivate Twilight II and try again. If the problem persists, read the “Check 
Your System Extensions” section in this manual for more information (especially the “Warning About Interrupts” 
section).

Applications stop performing tasks when Twilight II blanks normally. In Spectrum, this can be a problem if you 
are transferring a file or reading messages unattended. To avoid this problem, Spectrum asks Twilight II to use 
“background blanking” whenever you are online, and whenever a script is running. This means that normal 
screen blanking occurs only if all the following conditions are met:

•" “DCD is valid” is checked in the Port Settings dialog box,
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•" you have a properly-wired modem cable (see Appendix A),
•" the modem has been instructed to make the DCD signal valid,
•" you are not online, and
•" no script is running.

If any condition isn’t met, background blanking will be used. NOTE: If you move the mouse into a “blank now” 
corner, Twilight II v1.1 will do a normal blank because it is not honoring the background blanking request. If you 
have v1.1, contact DigiSoft Innovations to see if they have an update available to fix this problem (or just keep 
your mouse pointer away from any “blank now” corner).

Using High Speed Modems
When running a typical IIgs configuration with various system extensions installed and active, the system 
overhead can be taxing to the point where data loss occurs at 57,600 baud, so we recommend using 38,400 
baud or slower.

You might think that you must set the port speed to 57,600 or you won’t get the maximum benefit from your high 
speed modem, but in most cases that is simply not true.

When two modems connect, they first negotiate the highest rate both modems can handle. On the high end 
there are two possible connect speeds: 9,600 (V.32 modem) or 14,400 (V.32bis modem).

After connecting at one of those rates (and if error correction and data compression are enabled) the error 
correction and data compression protocol is negotiated. The best protocols are V.42 (up to 2:1 compression) 
and V.42bis (up to 4:1 compression).

There is only one case where you might need to set the Port Setting’s baud rate to 57,600:
•" You have a V.32bis modem (not just V.32),
•" the host you are calling has a V.32bis modem (not just V.32),
•" both modems connect using V.42bis (not just V.42) protocol, and
•" you transmit an “ideal” file that has not been compressed already with something like ShrinkIt-GS.

For all other situations 57,600 baud is simply not beneficial. If you have a situation where you want to use 
57,600 baud, keep these points in mind:

•# Sending information from Spectrum is no problem for the IIgs (Spectrum cannot lose characters that are 
being sent).

•" Receiving information might not go smoothly due to the IIgs system overhead (Spectrum’s port driver 
might not be called often enough to see all of the incoming data, and the resulting character loss will 
cause errors).

•" Receiving at 57,600 baud does work if you “Shift boot” the system (hold down the Shift key when you 
turn on the computer and no INITs/DAs will be loaded). Once you start adding system extensions that 
consume processor time—including things like AppleTalk or The Manager—incoming characters might be 
lost.

•" The H’ware Handshake port setting must be checked, and you must have a properly-wired modem cable 
(see Appendix A for cabling information).

•" A system accelerator (e.g. TransWarp or Zip GS) is highly recommended.
•" Use a file transfer protocol that can recover from transmission errors (e.g. Zmodem).
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Using The Manager
Spectrum requires The Manager version 1.1 or later.

Spectrum has already been configured to multi-task if The Manager is used (Spectrum’s application setup says 
“Can Receive Null Events”). To let Spectrum operate in the background, you must be using an application that is 
set to “Can Release Null Events” and The Manager’s preference must be set to “Allow background events.”

With those settings Spectrum will be able to operate in the background. As long as you are using a “TM-
compatible” online display, Spectrum can send and receive text, run scripts, and even perform file transfers in 
the background.

To activate another application, choose it from The Manager’s menu. If you are using an online display that 
doesn’t provide access to the menu bar, or the File Transfer dialog box is visible, hold down –Control and 
press Tab once or twice until the Finder or Mini Launcher appears. NOTE: It might take a while before The 
Manager sees the –Control–Tab key, especially during a file transfer. If The Manager still doesn’t see it after a 
few seconds, press the key combination again.

When The Manager determines that you want to put Spectrum in the background, it informs Spectrum. If an 
online display is being used that is not compatible with The Manager, Spectrum closes the display and 
automatically opens the Spectrum SHR Normal display so data can continue to be processed while Spectrum is 
in the background. When Spectrum is reactivated, the original online display is reopened automatically.

NOTE: The Spectrum SHR Normal display is slower than the Spectrum SHR Fast display. This is partly because 
the display is “following the rules” for drawing to the screen, and partly caused by multi-tasking (when Spectrum 
is in the background it is not a priority, so it gets very little time from the system).

File Transfers

As noted above, Spectrum can perform file transfers while it is in the background. However, you must be aware 
that what you do in the foreground application can affect the file transfer.

For example, if you print something in the foreground, Spectrum is “put on hold” until printing is finished (or until 
spooling is finished if you are using Express). Unless you’re printing an extremely small document, it is likely that 
the file transfer will “time out” and be aborted (especially at high baud rates).

Also, when Spectrum is in the background it will not be operating at full speed because it gets very little 
operating time from the system. Because of this, file transfers will take longer, and there is a much greater 
chance of transfer errors—especially if you have other system extensions using valuable processor time.

If you want to perform background file transfers, run the “Command.Tester” script and enter the following:
Set RelaxedXfers On

This command triples all the file transfer “timeout” values for this session (you must turn it on again the next time 
you start Spectrum). Note, however, that the system you are calling is not affected by this option; it might still 
time out if the transfer is interrupted.
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Please contact spectrumdaddy@mac.com if this section doesn’t answer your question!

Why is Spectrum losing characters?
Spectrum isn’t losing characters—it is never receiving them in the first place. Spectrum’s port driver is “interrupt-
based” and in order to not lose characters, it relies on getting interrupts regularly.

If you are regularly missing characters, it’s likely that you have one or more Control Panels (CDEVs), Desk 
Accessories (CDAs/NDAs), or System Setup files (INITs) that are also interrupt-based.

Because other interrupt-based extensions are also competing for interrupt time, the more of these extensions 
you have, the more likely it is that Spectrum will lose characters (especially at high baud rates). And if an 
interrupt-based extension takes too much time to do its job, even more characters will be lost.

Read the “Check Your System Extensions” section in this manual for more information (especially the “Warning 
About Interrupts” section).

Why do non-text file transfers have so many errors?
When an error occurs during file transfer it is an indication that the receiving end has detected an error in the 
information that was transmitted. 

During non-text file transfers, “packets” of information are transmitted. Each packet contains 128 or more 
characters, and every character that is sent must be received exactly for no errors to be reported. If a single 
character is wrong (or missing) then an error is reported by the receiver.

If you cannot send or receive a file you probably have a bad or noisy phone connection. Log off then try placing 
the call again.

If you can send files with no problem but receiving files causes many errors, then it’s likely that you have one or 
more interrupt-based Control Panels (CDEVs), Desk Accessories (CDAs/NDAs), or System Setup files (INITs). 
Read the “Check Your System Extensions” section in this manual for more information (especially the “Warning 
About Interrupts” section).

Also read the “General Tips” in the “Transferring Files” section for other file transfer tips.

Why does my modem get disconnected when I start a file transfer (and at other times it 
shouldn’t)?
Your modem cable is not wired correctly to support hardware handshaking. Choose Port from the Settings 
menu, uncheck the “H’ware Handshake” option, click OK, then choose Save Settings from the Settings menu. 
See <<AL>>Appendix A for cabling information.

When I abort a file transfer the host keeps sending data; can I make it stop?
When Spectrum aborts a file transfer it sends appropriate codes to the host to attempt to cancel the transfer. If 
the transfer doesn’t stop then the abort codes were either missed or not supported by the host.

To manually abort a transfer, try pressing Control-C and/or Control-X (not C or X) a few times. If the host still 
doesn’t respond, try choosing Send Break from the Phone menu.

Questions and Answers
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In the Port Settings dialog box, is there a reason to have both the “Xon/Xoff Flow” and 
“H’ware Handshake” options checked?
Yes. These two options control different things, and are used at different times.

“Xon/Xoff Flow” provides software flow control between Spectrum and the host, and normally should be 
checked.

“H’ware Handshake” provides hardware flow control between Spectrum and the modem, and should always be 
checked if your modem supports hardware handshaking and you have a properly-wired modem cable (see 
Appendix A for cabling information).

The Phone menu’s “Hangup” option is dim, but the modem is not hung up. How do I 
hang up?
Uncheck the “DCD Is Valid” option in the Port Settings dialog box, then try again.

Why does Spectrum say “modem not responding” when I dial a number?
The only time Spectrum checks for a modem response is just after sending the modem initialization sequence. If 
your modem is not responding at this point, turn the modem off, check the cables, the modem setup, and the 
port settings, then turn the modem back on.

If the modem still does not respond, perhaps you changed the modem initialization sequence. Choose Dial 
Number from the Phone menu, click the Set button, then click either the Standard or High Speed buttons to 
restore the correct modem initialization string.

Why is there a long pause when logging on to a system, where there was no pause 
with my previous telecommunications program?
Most likely the host you are connecting to has sent Spectrum a control-E “inquiry” character to try to determine 
what computer display is in use. Unfortunately, CompuServe B+ protocol also uses ^E to begin a file transfer. 
The long pause is caused because Spectrum is responding that it’s ready for a file transfer, which confuses 
some systems.

There are two solutions: First, some systems (e.g. CompuServe) let you turn off the initial “terminal type inquiry” 
option…once you set up your terminal type there is little need to change it, so changing the inquiry option is a 
good choice. Alternatively you can modify your logon script (assuming you’re using one) so that the “Auto 
Receive” file transfer option is temporarily turned off as you log in.

As soon as I type anything the screen begins filling with the letter I typed. Why?
The “Echo” option is probably checked in the Port Settings dialog box.

When you press a key, that character is sent out the port. Your modem (or the host you’re connected to) is 
sending that character back to Spectrum. The Echo option tells Spectrum to send every incoming character 
back out the port, so Spectrum does this (which starts the whole process over again).

Turn off the “Echo” option and this will stop. In general, Echo should be off unless you are running your own 
bulletin board or are connecting with a fellow Spectrum user (where one of you acts as the “host”). See “Echo” 
for more information.
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Appendix A
Modem Cable Wiring

Although all “IIgs to Modem” cables look alike (they all have a circular 8-pin connector on one end and a 
rectangular 25-pin connector on the other), the internal wiring can be quite different.

Spectrum can operate properly with as few as three wires connected (transmit data, receive data, and ground). 
Any modem cable (i.e. not a printer cable) will have these three connections, therefore any modem cable can be 
used with Spectrum as long as the “H’ware Handshake” option is off in the Port Settings dialog box.

However, to support “hardware handshaking” and other advanced features found in today’s high speed 
modems, you need a special cable that has several more wires connected. Naturally, those wires must connect 
the proper pins on each end of the cable or it will not function correctly.

Unfortunately there are several “standard” wiring designs for high speed cables. Spectrum supports the 
following cable standard for high speed telecommunications:

The high speed modem cable standard supported by Spectrum and other high-speed telecommunications 
programs for the Apple IIgs

Appendices
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This “High-Speed Modem Cable” can be purchased from Morgan Davis Group  for less than $20. Have your 
credit card handy and call (619) 670-0563 or FAX (619) 670-9643.

This cable design provides data carrier detection so Spectrum can know when you are online. It also supports 
hardware handshaking by connecting the port’s two handshaking signals to the modem’s “clear to send” and 
“ready to send” signals. NOTE: The modem must be set to ignore the DTR signal (see your modem’s manual; 
the typical command is &DØ).

Another Option

There is another cable format that is similar to the cable above, except the mini DIN-8’s pins 2 and 7 are 
reversed. This alternate cable format is sometimes used with the GBBS software.

If you have such a cable you can try using an alternate port driver that is provided with Spectrum.

➀ " Launch Finder (the program with a trash can icon).
➁ " Open the Spectrum folder.
➂ " Open the Add.Ons folder.
➃ " Rename “Spectrum.Port” to be “SP.Port.Main”.
➄ " Rename “SP.Port.Alt” to be “Spectrum.Port”.
➅ " Launch Spectrum.

If you still cannot accomplish high speed transfers, read the “Check Your System Extensions” section in this 
manual. If the problems persist you should order the standard modem cable described in the previous section. 
Also, don’t forget to rename the port drivers to their original names (rename “Spectrum.Port” to be “SP.Port.Alt” 
then rename “SP.Port.Main” to be “Spectrum.Port”).
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Appendix B
Common Hayes Commands

Spectrum works with Hayes-compatible modems, which use a common command language.

When you first turn on the modem it is in “command mode” (ready to accept commands). When you connect to 
another computer the modem switches to “data mode” (all characters are transferred to/from the modem without 
it trying to interpret the characters as commands).

To get back into “command mode” the modem must not receive data for a certain length of time, then it must 
receive three “modem escape codes,” then it must not receive data for a certain length of time (see Registers 2 
and 12). When this occurs the modem will respond “OK” and will be ready to accept commands.

While in command mode, the modem ignores spaces (or any characters not defined as part of its command 
set). To be recognized as a command, the line must begin with AT. All commands must be typed in uppercase. 
Multiple modem commands can be included on the same line, provided the line does not exceed 40 characters. 
The modem does not act on the command until Return is pressed.

The following list only describes the most basic Hayes modem commands (there are many others available). 
Refer to your modem’s manual for more information about these and other modem commands.

Some commands require a number or some other parameter. These parameters are shown as lowercase, italic 
letters. For example, in the command En, E is the command, and n  can be Ø or 1 (in actual use, EØ or E1 
would be used…not En).

Command Parameters Description

AT Attention code; precedes all command lines

A Answers call immediately (takes the modem “off 
hook” and attempts to connect)

Ds Dials a telephone number. s can be one or more of 
the following characters:

T use touch tone dialing

P use pulse dialing

, pause for [Register 8] seconds

; stay in command mode after dialing

Ø–9 numbers

* and # when using touch tone dialing, produces the same 
tones as the * and # buttons on the phone

En n=Ø do not echo characters while in command mode

n=1 echo back all characters while in command mode

Fn n=Ø half duplex

n=1 full duplex

Hn n=Ø on hook; hangup

n=1 off hook

Mn n=Ø speaker off always

n=1 speaker on until carrier detected
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n=2 speaker on always

O Return to online state (data mode)

Qn n=Ø result codes sent

n=1 result codes not sent

Sn=x n=Ø, 2–15
x=Ø–255

sets Register n to value x

Sn? n=Ø–16 modem sends value of Register n to Spectrum as a 
number from Ø–255

Vn n=Ø Hayes numeric result codes

n=1 Hayes verbal result codes (OK, CONNECT, RING, 
NO CARRIER, ERROR)

Z Causes a software reset and applies all default 
values (possibly as configured by switches on the 
modem)

The Sn=x command is used to set the contents of a “Register” in the modem, and the Sn? command can be 
used to read the current value of a particular Register. The following list describes only the most commonly-used 
Registers.

Register Range
Units

Default
(means) Description

Ø Ø–255
rings

Ø or 1 number of rings to answer on 
(Ø=no automatic answer)

1 Ø–255
rings

Ø
(Ø rings)

number of rings that have been 
detected (read only)

2 Ø–127
ASCII

43
(+)

character the modem recognizes 
as the escape code

3 Ø–127
ASCII

13
(return, ^M)

character the modem recognizes 
as carriage return

4 Ø–127
ASCII

1Ø
(down arrow, ^J)

character the modem recognizes 
as line feed

5 Ø–32, 127
ASCII

8
(left arrow, ^H)

character the modem recognizes 
as backspace

6 2–255
seconds

2
(2 seconds)

time to wait for a dial tone

7 1–255
seconds

3Ø
(3Ø seconds)

after dialing or answering, time to 
wait for carrier detect

8 Ø–255
seconds

2
(2 seconds)

when dialing, pause this long for 
each comma

9 1–255
1/1Ø seconds

6
(.6 seconds)

carrier detect response time

1Ø 1–255
1/1Ø seconds

7
(.7 seconds)

delay time between loss of carrier 
and hangup

11 5Ø–255
1/1ØØ seconds

7Ø
(.7 seconds)

duration and spacing of touch 
tones

12 2Ø–255
1/5Ø seconds

5Ø
(1 second)

modem escape code guard time
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Spectrum Version 2.0 through 2.5.3
This document describes what’s new in Spectrum versions 2.0 through  2.5.3. If you are upgrading from 
Spectrum v2.1 or later, refer to Spectrum’s online !Help! topic “Changes in Spectrum v2.5.3”  and “Changes in 
Scripting v2.5.3”  to learn about all the bug fixes and program feature changes made in the v2.2 through v2.5.3 
updates.

Significant changes to Spectrum’s scripting language were made in the v1.0 to v2.0 update, and additions were 
made in the Spectrum v2.1, v2.2, v2 and v2.4 updates. Bug fixes were made in the 2.5.2 and 2.5.3 updates. 
Rather than listing those changes on disk and having three separate script references, the changes have been 
repeated in this addendum. This also gives us an opportunity to correct an oversight in the v2.0 addendum…this 
addendum includes an index!

Spectrum is no longer distributed by My eSource, formerly Seven Hills Software. All sales were handled by 
Syndicomm™. The references to Seven Hills in the ‘Getting Started’ and ‘Scripting’ manuals have been 
retained, as these reflect the status of Spectrum when those two manuals were first printed.

Spectrum is now Freeware, and can be downloaded from: htpp://www.wannop.info/speccie

Credits

Spectrum version 2 was a team effort that would not have been possible without all of our beta testers, so we 
thank all of them for their efforts to make Spectrum as bug free as possible.

We’d especially like to thank Ken Lucke for alpha testing Spectrum many months before it went into beta (his 
diligence in testing and retesting each incremental update resulted in a very smooth beta testing period). Thanks 
also for writing and maintaining Help files, for all the scripting suggestions, and for writing scripts that actually 
used those new commands! Finally, thanks for the general support and encouragement, it has been 
appreciated.

And the greatest appreciation must go to Ewen Wannop  who spent too many evenings and weekends writing 
version 2 instead of gardening! If it wasn’t for his incredible patience in adding new scripting features at every 
turn, Spectrum wouldn't be what it is today.

Notes

To learn about most of Spectrum, read the Getting Started and Reference manual. Once you are familiar with 
the original Spectrum features you can then read the “New or Changed Program Features”  section below to find 
out what’s new in version 2.0 or later. Likewise, when you begin writing scripts you should read the Scripting 
manual to learn about the original Spectrum features, then read the “Script Language Changes” section below to 
learn what’s new in version 2.0 onwards.

Addendum

http://www.wannop.info/speccie
http://www.wannop.info/speccie
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Installation Instructions
If you are a new owner of Spectrum: Follow all the installation instructions in the Getting Started and Reference 
manual. If you install Spectrum sounds you should also run the “SoundPatch” utility to add some new sound 
events into the Sound CDEV.

If you purchased the floppy disk version of Spectrum v2.2, you will need to download the Spectrum v2.5.3 
Updater:

<http://www.wannop.info/speccie>

If you purchased Spectrum version 2.2 on floppy disk:
✽ Insert the original Spectrum Install disk.
➀  Run the Installer, and when you are asked to do so, type your full name then click the OK button.

 When personalization is complete, Apple’s Installer is launched automatically.

➁   After installation, locate the Spectrum 2.5.3 updater archive, and run the Install script to update from 
Spectrum v2.2 to Spectrum v2.5.3.

If you purchased Spectrum version 2.5.3 on floppy disk:
✽ Insert the original Spectrum Install disk.
➀  Run the Installer, and when you are asked to do so, type your full name then click the OK button.
" When personalization is complete, Apple’s Installer is launched automatically.

If you purchased the CD version of Spectrum version 2.5.3:
✽ Drag the Spectrum folder to your hard drive to make the ‘Spectrum.2.5.3’ folder.
➀  Run the Installer, and when you are asked to do so, type your full name then click the OK button.

" When personalization is complete, Apple’s Installer is launched automatically.

If you will use Spectrum on a hard disk drive:
Skip to the next page if you use Spectrum with 3.5" disks.

➂  Select the “Spectrum 2.5.3” script and click 
the Install button. Outdated files will be 
removed, and Spectrum v2.5.3 will be copied 
to the disk that was used to start up  the 
computer. NOTE:  If you want to install 
Spectrum to some other disk, click the Disk 
button until the disk is displayed.

➃  After the update is installed, click the Quit 
button.

➄  Launch the “SoundPatch” application and 
follow the on-screen prompts to update your 
Sound Control Panel (CDEV) so it lists all the 
currently defined “sound events.”

➅  Choose Control Panels from the ð (Apple) 
menu, then open the “Sound” CDEV.

➆  Assign the sounds you want by selecting an 
event from the Event popup  menu, then 
choosing the sound to be associated with 
that event from the Sound popup  menu. For 
example:

Event Suggested Sound
File Transfer Complete Send/Receive-Good

or Ahh or Trumpets

File Transfer Failed/Abort Send/Receive-Bad

Grabbing Screen Saving Screen

Key Click Key-Any

Modem Connected Phone-Connected

Modem Hanging Up Phone-Hangup

Modem No Carrier Phone-No Connection

RealTime Message Phone-Connected
or Trumpets

Return Key Key-Return

Space Key Key-Spacebar

You Have Mail You Have Mail
or You Have Mail (HAL)

http://www.versiontracker.com/
http://www.versiontracker.com/
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⑧  If you experimented in step  ➆  by choosing several sounds to hear what they sound like, choose Shut 
Down from the Special menu, then select the Restart option and click OK to restart the computer. The 
reason for restarting is that the Sound CDEV is now probably using a lot more memory than it needs to 
be, and restarting will fix that.

➈  Now launch Spectrum version 2.5.3!

To install the !Help! NDA System and documentation for Spectrum:
➀ " Select the ‘Spectrum Help System’ script and click the Install button. The !Help! NDA and related 

documentation will be copied to the ‘System:Desk.Accs’ folder on your boot drive.
➁ " Reboot your hard drive to install the !Help! NDA into the Apple Menu. 

If you use Spectrum with 3.5" disks:
See the previous section if you will use Spectrum with a hard disk drive.
➂ " Choose Quit from the File menu and the Finder reappears.
➃ " Make a backup copy of the Spectrum update disk.
➄ " Drag the original Spectrum update disk icon into the Trash to eject the disk and remove its icon from the 

desktop.
➅ " Insert the backup copy of the Spectrum update disk.
➆ " Rename the backup disk to be “Spectrum”.
⑧ " Drag the following items into the Trash:
" ❏ Prefs.Convert
❏ Install
❏ Misc.

➈ " Choose Shut Down from the Special menu then click OK to shut down (turn off system power). You can 
now start using Spectrum v2.5.3 just as you have been using Spectrum v1.0 or later.
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This section describes the program feature changes made in all versions of Spectrum from Spectrum v2.0 
through v2.5.3. Refer to Spectrum’s online !Help! topic “Changes in Spectrum 2.5.3” to learn about the recent 
bug fixes and program feature changes made in the v2.2, v2.3, v2.4, v2.5.2 and 2.5.3 updates.

You will immediately see some changes with the Spectrum™ v2.5.3 menus. These are mainly to include the 
integrated support of Marinetti™ 2.0 and its TCP/IP environment.. This has led to a number of additional script 
commands to support TCP/IP through scripting. There are also a few other new menu items that have been 
added since Spectrum™ 2.1. 

Underneath the surface there have been many changes, bug fixes, and new script commands added. Most of 
the additional script commands have been designed to enhance and improve script functionality, and many are 
a result of limitations found while developing both “Spectrum Internet Suite™” and other script sets. Some of the 
XCMDs have been expanded since the release of Spectrum v2.1. Some of these XCMD updates have already 
been issued with the various script sets, but the latest versions of all the current XCMDs are included with this 
release of Spectrum, and should be used in place of existing versions. Some existing XCMDs that are no longer 
required will be removed by the Installer.

The Spectrum™ 2.5.3 update did not introduce any major feature changes from Spectrum™ 2.2. A small 
number of script commands have been added however, and a number of minor bugs have been fixed.

General Changes & Bug Fixes
NOTE: The version 2.2 to 2.5.3 Preference file format has been extended to support new features. Version 2.x 
preference files are converted automatically to the new format. The new format cannot be used with older 
Spectrum Pref files.

•" In v2.2, the code was significantly reorganized to make room for more features. The protocol transfer 
code and some of the dialog code have been put into two dynamic segments to be more memory friendly.

•" The Spectrum Port driver wasn’t forcing unused high-bits off (i.e., when a 7-bit data format was selected it 
was possible for the 8th bit to be set). Fixed.

•" The Spectrum Port driver stopped liking DataLink modems, especially on ROM01 machines. Fixed.
•" Made more refinements to try to reduce data loss:
Removed a _TickCount call from the timer routine.
Now waits for VBL to cycle when changing hardware handshake status.
Added support for “II Not Disturb” to automatically turn “Master Time Keeping” on and off whenever Spectrum 

is started and quit.
•" ^G  (SysBeep) has been reworked so the correct Sound CDev sound should be played. Now the interrupt-

friendly (raspy) beep will play only if Hardware Handshake is not checked and a carrier is detected.
•" If an XCMD or Online Display is not loaded successfully, now a beep is sounded and the item’s name is 

displayed for one second in the “Loading” status area.
•" We added the capability for XCMDs to add custom menu items into Spectrum’s menus. Several supplied 

XCMDs take advantage of this feature, including HodgePodge and Kermit.
•" A new “”  (solid black apple) menu has been added to the right of the Settings menu. The new menu is 

shown only when an XCMD has added an item to it.

Feature Changes
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•" Fixed a problem where the menu bar clock would not change to “am” at midnight or “pm” at midday 
unless the clock was fully updated (e.g., by a window closing or other similar event).

•" Alerts now use “the latest cool button layout.”

• " From Spectrum™ v2.2 onwards:
Spectrum™ now requires System 6.0.1. A hard disk is recommended. 
Improved script execution speed through a reorganization of the matching algorithm.
Scripts can be compiled to optimise their execution speed.
Spectrum™ and the XCMDs are now Y2K compliant, where appropriate, additional script commands 
have been added..
Spectrum™ now features integrated support for Marinetti™ 2.0 TCP/IP.
HTML files can be viewed directly from within Spectrum™.
Internal support for the Babelfish™ Import and Export. Engine.
New internal “Preferences” folder.
Spectrum™ now looks first for the “Spectrum2.Prefs” file in the internal Preferences folder, before it 
looks in the System folder. This allows multiple copies of Spectrum to run smoothly.
Conversion of old preference files no longer causes problems.
Spectrum™ now supports the Control Panel version of Hierarchic. If not already active, Hierarchic will 
auto-load if the CDev is present in the CDevs folder.
The Spectrum™ Port driver has been updated.
Support for ‘finderSaysBeforeOpen’ calls to open Text files automatically.

• " From Spectrum™ v2.3 onwards:
An X/Y/Zmodem bug that slowed transfers and caused increased checksum errors has been fixed.
A workround has been made for a bug in the Marinetti 2.0 TCP/IP stack. This could cause Spectrum to 
crash if a socket closed when more than 4K of data was returned.
The RESUMENEXT script command now works correctly.
Fixed a problem in the “Search File” script command that caused an endless loop  under certain 
circumstances.
Fixed a problem with sending Text files showing the wrong size in the Status dialog.
Fixed some interaction problems with Hierarchic and custom menus.
Fixed a Hangup problem when DCD and Hardware Handshake were not checked.
Fixed the reversed paths for “Set SendPath” and “Set ReceivePath”.
Improved the renaming algorithm when receiving duplicate files.
Fixed a problem that would cause endless looping if the receive filepath was not found.
Fixed a problem that could cause hanging if the Capture Buffer filled during batch downloading.
Fixed a problem that could cause overwriting on the Text screen during downloads.
Improved the handling of the WindowMgr Menubar switching.
Fixed a bug in Evaluate where a number to the power of ‘0’ was returning an incorrect value.
OA-G no longer clears the Text or VT100 screen display if they are already open.
Improved recovery from cancelled X/Ymodem transfers.
Fixed an intermittent lock up on printing.

• " AppleWorks 5.0 documents include Inverse and MouseText characters. These will now display correctly 
within the Editor, though the Inverse attributes will be stripped. These characters will also be sent correctly 
if you send an AppleWorks file as text.

• " There is a bug in the original GSPlus™ XCMD that can cause it to interfere with the messages being sent 
to other XCMDs. If you have been using this XCMD, you will find a new version supplied with Spectrum™ 
2.5.3 that cures these problems.

• " Version 2.5.3 fixed some problems with the TCP/IP data interface.
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 (Apple) Menu
•" Removed Spectrum’s built-in help  in favor of the !Help! NDA (which is included with Spectrum). If you 

don’t want any help  you can inactivate the Help.NDA desk accessory (located in the System:Desk.Accs: 
folder).
If you want help  only while Spectrum is being used (even if you have Shift-booted the computer) you can 
move the Help.NDA into the same folder as the Spectrum application. If Spectrum loads the NDA, it is 
unloaded when Spectrum quits.
Regardless of where the Help.NDA is located, the NDA always looks for its files in the 
Desk.Accs:Help.Files: folder.

•" Added “Menu Item Help” that dims every menu item except those owned by Spectrum, and changes the 
mouse pointer to a “menu item help” pointer. When a menu item is selected, Spectrum asks the !Help! 
NDA to display the appropriate help information.

NOTE: Spectrum cannot dim the TransProg III menu (if present). If you select an item from the TPIII menu, 
the help request is transmitted to !Help! but then TPIII will attempt to launch the item you selected.

File Menu
Open

•" Option-opening a file of type $50 could cause a crash because Spectrum was interpreting all filetype $50 
files as Teach files. Fixed.

•" Loading an empty file into the Editor changed the name of the Editor window to the empty file’s name, 
even though the Editor contents were untouched after an error message was shown. Fixed.

• " Holding the Option key down now allows the data or the resource fork (if present) of a file to be opened. 
•" If a file with the suffix ‘.HTM’ or ‘.HTML’ is opened, and the optional ‘HTML.Engine’ is present in the 

‘Add.Ons:Drivers’ folder, you will be asked if you want to view the file as HTML. You will still see the file in 
its raw text form in the Editor after you have finished viewing the HTML display.

Save
•" The correct filetype is now set on “saved as” files.
•" With an autosave file set up, Save As will allow saving of the current buffer independently from the Save 

command.
•" Added a clarification message when autosaving a buffer to a full disk.
•" If you opened an AppleWorks file into the Editor, then File/Saved it, the file is saved as Text instead of 

AppleWorks. Fixed. (Use Save As to save as a different file type.)

Babelfish™ 
• " Babelfish™ Import and Export is now supported.  This requires Babelfish™ to be installed, and Text filters 

to be available. See the Babelfish™ documentation for further details.

Send/Receive
•" Added the ability to transfer files that have a resource fork, by using a MacBinary header. Because the 

receiver must be capable of receiving and processing a MacBinary file, the default file transfer 
preferences are set so files with a resource fork cannot be transmitted. If you decide to change this 
preference, be sure the recipient is able to handle the file.

•" If you received a file via Zmodem to a P8 volume, and the file had a period as the first character, 
Spectrum was doing strange things and reporting non-existent errors. This was caused by a bad 
JudgeName call. We also found that if you received a file by Zmodem that required JudgeName, the 
transfer did not complete properly. Both items have been fixed.
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•" A “Make this folder default” checkbox has been added to the file selection dialog boxes for all built-in file 
transfer protocols. When checked (and you accept a file to transfer) the folder that contains the file is 
stored as the default send or receive file transfer path. The choice is not written to the preferences file 
unless the settings are saved.

•" When sending a text file, Macintosh text files would not be selectable. Fixed.
•" When sending Xmodem ProDOS, the received file would be truncated. Fixed.
•" Fixed a Zmodem escape character problem that showed on some host systems.
•" The Freezer XCMD is no longer necessary, as its functionality has been incorporated directly into 

Spectrum.
•" Spectrum was forcing filenames to lowercase for Zmodem and Ymodem receives. Fixed.
•" If an incoming Zmodem file happened to have a colon or slash in its embedded filename, a “file not found” 

error would occur and the transfer would abort. Most Zmodem implementations do not pass these 
characters, but some do, so Spectrum now replaces those path separators with periods.

•" Spectrum does not attempt to extract files from a Binary II wrapper if there are multiple files enclosed 
because it would be nearly impossible to resume a transfer. To help  alert the user that he needs to use 
some other program (like ShrinkIt) to extract the multiple files, a message is now added to the capture 
buffer that says “WARNING: A Binary II header holding multiple files was not unpacked.”

•" Removed the code to resume CIS B+ uploads because CompuServe has never implemented that 
capability.

•" The file transfer status dialog box now shows whether a Binary II or MacBinary header is present on the 
incoming/outgoing file.

•" When using CIS B+, if you typed only a filename to send or receive, the correct file transfer folder was not 
always set properly. Fixed.

Launch
•" Fixed a problem that would not let the Hangup checkbox be unchecked.

Quit
•" If you opened the SHR screen, then the Editor, then opened the VT100 display, then go back to the Editor 

and File/Quit, lots of windows would appear, disappear, reappear, etc. as the windows were closed in a 
fixed order. The windows are now closed in the order in which they are layered.

Edit Menu
Paste

•" If text had been copied into the Clipboard, Paste was not highlighted when the Editor was first opened. 
Fixed.

•" V did not work in VT100 if the chat line had been open in the Spectrum Text screen. Fixed.

Paste As Reply
•" This feature didn’t work right if the selected text was greater than 76 characters. Fixed.

Find/Replace
•" Pasting into the Find box now activates the Find button.
•" The “apply/replace” script command was changing some choices in the dialog box. Fixed.

Signature 
• " If a Signature has been defined by the ‘Set Signature’ script command, this will insert that Signature into 

any open TextEdit window.
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Show Menu
Online Display

•" j did not work from some online displays; you had to press ð-Shift-J. Fixed so it is no longer case 
sensitive.

•" When displaying echoed information, characters were routed to the script screen vector instead of the 
normal screen vector, which caused some information to be lost. Fixed.

Editor
•" Added more support for extended keyboards (the small “forward delete” key, Home, End, Page Up, Page 

Down).
•" If an NDA or other concurrent application sends a ‘finderSaysBeforeOpen’ call, and Spectrum™ gets the 

call first, the filetype will be checked to see if it is a Text, Teach or classic AppleWorks file. If so, it will be 
opened into the Editor. An example is double-clicking a Text file displayed in a Disk Access II™ catalog, 
when Spectrum will open the file before Disk Access II™ opens its default window.

Clipboard
•" The clipboard window can now be printed. The window is also now “editable” in that you can highlight 

some text in the Clipboard window and Edit/Copy it…which deletes all of the clipboard contents and 
replaces it with the text you had highlighted.

Chatline
•" If you press the down arrow in the first or second line when the cursor is to the right of the end of the next 

line, the cursor jumps to the end of the next line instead of sticking, and not moving as expected.
•" If the chatline was full, pressing the Arrow keys would cause a beep. Now it beeps only when attempting 

to add a character.
• " If you are using the SHR display, you can now move around the Chat Line by clicking with the mouse.

Phone Menu – TCP/IP Menu
Please refer to the documentation that comes with Marinetti™ for full details on how to setup and activate TCP/
IP through the TCP/IP Control Panel.

Dial Number - Services
•" Spectrum no longer auto-dials the next phone number if the current phone number fails to connect.
•" Linking a script to a dialing entry no longer corrupts the first character of the filename.
• " From Spectrum™ v2.3, Dial Number still operates as before, but if the optional TCP/IP Menu is selected 

instead, this item will be renamed to Services. 
•" The Modem Init dialog has been changed to show a “popup” menu of modem types instead of the original 

“Normal”  and “High Speed” strings. The file that is used to build this menu is held in the new “Preferences” 
folder and so can be edited if you wish. 

• " “Services” leads to a similar dialog to the “Dial Number” dialog. You can create and edit a service list of 
your most used services. You can also connect directly to a system by entering an “IP name” or “dotted 
address” into the Connect box.

• " “Telnet” mode can be optionally selected. In Telnet mode, the setting of the Half Duplex flag is ignored, 
and echoing to screen will be controlled by the host you are currently connected to.
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Hangup - Connect - Disconnect 
• " In Serial mode, the ‘Hangup’ menu item is dimmed if offline.
• " In TCP/IP mode, the ‘Hangup’ menu item is renamed to either ‘Connect’ or ‘Disconnect’. ‘Connect’ will 

make a connection to your ISP. ‘Disconnect’ will warn if you have any active connections, and then 
Disconnect you from your ISP.

Switch to TCP/IP - Switch to Serial 
• " Controls the switching between the two operating environments. When in Serial mode, the menu items 

are named as before, but when in TCP/IP mode, some menu items now have new names and functions:

Answer Back - Logout 
• " Answer Back operates as before.
• " Logout logs you out from the currently active connection.

Service Items 
• " When you have logged in to a service, the connection or socket names will be entered at the foot of the 

TCP/IP menu. Each menu item is numbered, and you can then switch between active connections by 
selecting from this menu. You can also link these items to FKeys, by running the ‘TCPIP.FKeys’ script.

Script Menu
See the “Script Language Changes” section for the list of changes that affect scripts. 

Learn a Script 
• " This will now record any pause from the last character being received, and a string being transmitted.  

This should help produce improved scripts where time sensitive actions are important.  You should always 
subsequently edit generated scripts so they are optimised for best results.

Menu Files 
• " These files can now have optional pathnames that will be used instead of a linked “Letter” key. A space 

can also now be used instead of a “Letter” key. To build the file, ‘tabs’ are used to space any pathname 
that is given from the menu name. This now means that a Menu file might look like this:

  " A " First Script
  " B " Second Script with path<tab>:hard.disk:folder:filename
    "" Third Script with path<tab>:hard2.disk:folder:filename

Settings Menu

Online Display
•" The “Spectrum SHR Fast” and “Spectrum SHR Normal” displays have been combined into a single 

“Spectrum SHR” display that automatically switches between the fast and normal display modes as 
necessary.

•" If Delete=Backspace is checked, character $08 is sent out the port when the Delete key is pressed, rather 
than whatever key sequence is associated with the left arrow key.
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ANSI
•" There was a slight possibility that commands with multiple parameters (e.g., ESC[31;47m) could be 

trashed. This has been fixed.
•" The underline character attribute is now supported.
•" Supports the direct actions Debug On and Debug Off to control whether unknown/unsupported Escape 

codes are displayed in the Status Line. For example:
DirectAction "Debug ON" 0
DirectDisplay "^[[8a"

•" Escape sequences which do not have commands are ignored (or reported as invalid if display debugging 
is on).

•" Invalid SM and RM commands are tolerated better.
•" Supports Insert and Replace Mode (IRM) using the SM and RM commands with a parameter of 4 (e.g. 

ESC[4h) sets the mode so characters are inserted instead of replaced.
•" Supports Horizontal Editing Mode (HEM) using the SM and RM commands with a parameter of 10 (e.g. 

ESC[10h) sets the mode so editing commands (insert/delete) go left instead of right.
•" Supports the Insert CHaracter (ICH) command to insert a specified number of blank characters at the 

current location (respecting the HEM mode). For example, ESC[3@ inserts 3 blank spaces.
•" Includes custom support for Genie’s Internet services.

Options
• " The old “File Transfer Settings” submenu has been renamed. This better reflects its use by many of the 

XCMDs. For details of any additional Menu items, refer to the ‘Spectrum Extras’ subject, and the relevant 
sub-topic of the !Help!  NDA.

The Options menu item now presents a sub-menu with Receiving Options and Sending Options and other 
Options items inserted by XCMDs. Most of the options existed in Spectrum v2.0; the new or changed items 
are as follows:
•" SendAhead is relevant for both sending and receiving, but different protocols handle SendAhead 

differently. Because there is really only a single SendAhead option, if you change the setting in the 
Sending Options dialog box, it will also change in the Receiving Options dialog box (and vice-versa).

•" The Sending Options dialog lets you specify the location of the files to be sent. The Receiving Options 
dialog lets you specify the default location for storing received files. In each case you can choose no 
default location, and files will be sent from/received into the most-recently used folder.

•" The Receive Options dialog lets you specify the filetype and auxtype to be assigned when the received 
filetype/auxtype is unknown.

•" MacBinary is now supported so files with a resource fork can be transmitted to other Spectrum v2.4 
owners, to Macintosh computers, or to others who can process a MacBinary header.

.

External Commands (XCMDs)
The “Spectrum Extras” subject and sub-topics in the !Help! NDA contain complete documentation on the new 
and updated XCMDs provided with Spectrum v2.4. 
NOTE: The Freezer XCMD is no longer necessary  because its automatic features are included directly  in 
Spectrum v2.1. It can still be used if your scripts want to freeze the mouse manually.
The following XCMD-related changes were made to Spectrum itself:

•" Unclaimed control hits might not have been seen by XCMDs correctly. Fixed.
•" The version number in Spectrum’s _AcceptMessage call has been changed to 2.1.
•" The BinHQX XCMD has been expanded since Spectrum™ 2.1, to include Base 64 and UUencode 

functions.
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•" NOTE: The TopCat, BatchXfer and Freezer XCMDs are no longer necessary because their features have 
been incorporated directly into Spectrum™ v2.4. 

• The ResEdit XCMD has been replaced by the WorkBench XCMD .

TCP/IP
Spectrum now has two modes of working. The original Serial connection mode and a new TCP/IP mode. You 
must have the Marinetti™ TCP/IP Cdev installed and configured to use the TCP/IP mode.
If you regularly use any other communications programs, you may wish to use Serial mode as your default 
setting when Spectrum first starts up. If TCP/IP has made an active connection by another application before 
Spectrum is started, TCP/IP mode will be forced, regardless of your default settings. If you wish to continue with 
a serial connection, you must first Disconnect TCP/IP by either selecting Switch to Serial on the TCP/IP menu, 
or by calling the Set Serial script command.
If the TCP/IP CDev or another application makes the connection, Spectrum will be forced into TCP/IP mode 
when it starts. You will see an Alert box warning you of this.
When you Quit Spectrum, if TCP/IP is still Connected, any open sockets will be closed automatically whether 
TCP/IP is disconnected or not.

TCP/IP Menu
Services 
Choose Services to Connect to a host or to create Service entries for the systems you call.

Services Entries
Click New to create a new Service entry; to edit an existing entry highlight it and click Edit.
Up  to 32 Service entries can be created within the list. Each Service entry remembers the dotted address or 
system name that you enter, an optional linked script, and the required display. If you choose ‘Default Display’, 
then the current display will be used. Unlike the phonebook entries, a Service entry does not remember other 
settings, as these are not directly relevant to a TCP/IP connection. The Service list is stored as a text file in the 
‘@:Spectrum:Add.Ons:Preferences:’ folder. This file can be manually edited if you wish. The ‘Tab’ separated 
fields for each line are: Entry Name, Address, Script and Online Display.

Login
Double click an entry from the list, or enter the dotted address or host name into the Connect box.  If you are not 
already online you will automatically be connected.

Telnet
The Telnet mode is the default mode used for most services.  It will be automatically set whenever you open the 
Services dialog.  If you do not wish to connect in Telnet mode, then uncheck the 'Telnet' box before logging in.  
Note that the setting of TCPEOLTranslation, TCPFlushChar and TCPFlushFrequency will all affect the keyboard 
responses if Telnet mode is turned off.
TIP:  If the connection fails, and you cannot Disconnect normally, you may find that the modem is still online. 
Quickly switch to Serial mode, select the same baud rate that TCP/IP was using, and select Hangup to drop the 
line.
TIP: If you do not want to see messages while you connect, or do not want the Capture buffer and screen to 
record a switch of services. uncheck the respective checkboxes.

Connect - Disconnect 
If you are not yet connected to your ISP, the menu will show Connect, and will connect you to your ISP.  Choose 
Disconnect to logout ALL active Connections and Disconnect from the host.  If there are Connections active, you 
will be warned and have the option to Cancel.
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Once connected, you will still need to login in to a service from the Services dialog.

Send Break 
This menu item will be dimmed while TCP/IP is active.

Switch to Serial 
This menu item will switch to the Serial mode from TCP/IP mode.

Close Connection 
Choose Logout to logout from the currently selected Connection shown by the √ marker. If there are other active 
Connections, then the first of these will then be selected as the new active Connection.

Connections: 
Each connection you open will add an entry to the end of the TCP/IP menu. If the chosen Connection was 
opened from an item in the Service List, or the optional MenuName was used in the Open TCPSocket script 
command, then that name will be used for the Menu item. Otherwise the domain name or dotted address will be 
used. Each entry is numbered to show the logical Connection.
You can change active connection by selecting a new one from those shown. A √ will show against the current 
active Connection.
When you switch Connections, the current display type, screen contents, and up to 32K of the Scrollback Buffer 
will be preserved. If you then switch back to this Connection later, the display will be restored as it was when you 
last viewed it.  If a script has set the ‘Set Screenbypass ON’ flag, then the displays will not be reopened 
automatically.  Note that with a large number of sockets open, you could eventually run out of memory if all the 
Scrollback Buffers were full. It is advised to size the Scrollback Buffer to suit the number of Connections you 
might expect to use.
When you switch Connections, a marker line will be added to the Capture buffer, to show a new Connection has 
been selected.
Tip: Define your FKey Menu items for the first ten connections. You then be able to quickly switch these by using 
the OA-# equivalent.
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1K Xmodem  22, 24
4K Xmodem  22, 24

A
About Spectrum  4
Add Line Feeds  30
AE DataLink Modem  42
All Lower Case (Text Format)  30
All Proper Names (Text Format)  30
All Upper Case (Text Format)  30
Answer Back  36
Answers to Common Questions  56
Append Selection To Editor  28
Apple () Menu 

Desk Accessories  67
Help  21

Apple Menu  
About Spectrum  21

Auto Buffer Control  43
Auto Receive  45

B
Babelfish™  67
Baud Rate  40
Binary II Down  46
Binary II Up  46
Buffer Size

Capture Buffer  31
Port Buffer  40
Scrollback Buffer  42

C
Capitalize Sentences (Text Format)  30
Capture  24
Capture Buffer  31, 42
Capture To File  25
CDAs  17, 21
CDEVs  17
Change LFs Into CRs  30
Character Delay  41
Character Filter Settings  44
Chat Line  32

Check Startup Device  11, 16
Check Your System Extensions  17
Choose Font  28
Choose Printer  25
CIS B+  22, 24, 51
Classic Desk Accessories  20, 21
Clear  27
Clear Capture Buffer  25
Clear Menu File  39
Clear Timer  60
Click (mouse)  11
Clicks  43
Clipboard  32
Clock  43, See also Timer
Close  22
Command Keys  19

' (Paste as Reply)  27
*(Rerun Script In Memory)  38
, (Start Timer)  36
, (Stop Timer)  36
-Control-Esc  30
; (Append Selection To Editor)  28
= (Capture Off)  24
= (Capture On)  24
\ (Show Scrollback)  32
` (Show Chat Line)  32
– (Run Editor As Script)  38
A (Select All)  27
B (Send Break)  35
C (Copy)  27
D (Dial Number)  33
E (Show Editor)  31
F (Find/Replace)  30
G (Online Display)  31
H (Hangup)  35
I (Send Text File)  23
J (Send Editor Text)  23
K (Format Text)  29
L (Learn A Script)  37
M (Send Clipboard To Modem)  28

Index

This index attempts to reference all the topics you might look up. 
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M (Send Selection To Modem)  28
N (New)  22
O (Open)  22
P (Print)  25
Q (Quit)  26
R (Run A Script/Stop Script)  38
S (Save)  22
Spacebar (Show Status Line)  32
V (Paste)  27
W (Close)  22
X (Cut)  27
Y (Choose Font)  28
Z (Undo)  27

Control Panel  21
Control Panel Devices  17
Convert To Low ASCII  29, 43
Convert Viewdata To Text (Text Format)  30
Copy  27
Copying Disks  13
Creating Phonebook Entries  33
CRs Into Spaces  30
Cut  27

D
Data Format  40
DataLink Modem  42
DC Printer  21
Delete Key = Backspace  43
Desk Accessories  21
Dial Number  33, 36
Double-Click (mouse)  11
Drag (mouse)  11
Duplex  40

E
Echo  41
Edit Menu  27

Append Selection To Editor  28
Choose Font  28
Clear  27
Copy  27
Cut  27
Find/Replace  30
Format Text  29
Paste  27
Paste as Reply  27
Select All  27
Send Clipboard To Modem  28
Send Selection To Modem  28
Text Color  29
Undo  27

Edit Menu (v2.5.3)  68
Editing Phonebook Entries  33

Editor  31
Editor Text  23
External Commands (XCMDs) (v2.5.3)  71
Extensions  17

F
Feature Changes (v2.5.3) 65
File Menu  22

Capture  24
Capture To File  25
Clear Capture Buffer  25
Close  22
Launch  26
New  22
Open  22
Page Setup  25
Print  25
Quit  26
Receive File  24
Save  22
Save As  22
Send File  22

File Menu (v2.5.3) 67
File Transfer Settings  45
Find/Replace  30
Finder  12
Format Text  29, 30
Full Duplex  41

G
General Changes & Bug Fixes (v2.5.3) 65
Getting Started  10
Guided Tour  16

H
Half Duplex  40
Hangup  35
Help  21

I
Initialize Modem Before Dialing  34
Initializing Disks  12
INITs  17
Installer Program  12, 14
Installing (v2.5.3) 63
Introducing Spectrum  17

K
Keyboard  10
Keys  10

L
Launch  26
Learn A Script  37
LFs  41
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Line Delay  41
Line Feeds (LFs)  41
Lines Into Paragraphs  23
Load Menu File  34
Load Settings  46
Logon Script  34

M
Menu File  39

Format  39
Menus  19

Edit  27
File  22
Phone  33
Script  37
Settings  40
Show  31
 (Apple)  21

Modem Initialization  34
Modem Not Responding  35
Modem Port  42
More Display Options  44
Mouse  11

N
NDAs  21
New  22
New Desk Accessories  17, 21
New Phonebook Entry  33

O
Online Display  31
Online Display Settings  42
Open  22
Open-Apple Keys  See Command Keys

P
Packet Send Ahead  46
Pad Empty Lines  46
Page Setup  25
Paragraphs into Lines  23
Paste  27
Paste as Reply  27
Permanent INITs  17
Phone Menu  33

Answer Back  36
Clear Timer  36
Dial Number  33
Hangup  35
Send Break  35
Start Timer  36
Stop Timer  36

Phonebook Entries  33
Port Buffer Size  40

Port Settings  40
Press (mouse)  11
Print  25
Printer Port  42
ProDOS Xmodem  46

Q
Questions and Answers  56
Quick Keys  See Command Keys
Quit  26

R
Receive  24

1K Xmodem  24
4K Xmodem  24
CIS B+  24
Xmodem  24
Ymodem Batch  24
Ymodem-g  24
Zmodem  24

Recognize  Script Keys  43
Reference Section  19
Remove All Unnecessary Control Characters  30
Remove Extra Spaces  30
Requirements  10
Rerun Script In Memory  38
Resume Transfers  45
Run A Script  38
Run Editor As Script  38

S
Save  22
Save As  22
Save Settings  46
Script Menu  37

Clear Menu File  39
Learn A Script  37
Load Menu File  38
Rerun Script In Memory  38
Run A Script  38
Run Editor As Script  38
Stop Script  38

Script Menu (v2.5.3) 70
Scrollback  32
Scrollback Buffer  42
Select All  27
Send  22

1K Xmodem  22
4K Xmodem  22
CIS B+  22
Editor Text  23
Text File  23
Xmodem  22
Ymodem Batch  23
Ymodem-g  23
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Zmodem  23
Send Break  35
Send Clipboard To Modem  28
Send LFs  41
Send Selection To Modem  28
Send Text Prompt  46
Settings Menu  40

Character Filter  44
File Transfer  45
Loading  46 
More Display Options  44
Online Display  42
Port  40
Saving  46
Status  47

Settings Menu (v2.5.3) 70
Shift Boot  17
Shortcuts  See Command Keys
Show Menu  31

Capture Buffer  31
Chat Line  32
Clipboard  32
Editor  31
Online Display  31
Scrollback  32
Status Line  32

Show Menu (v2.5.3) 69
Slot Number  42
Sounds  43
Special Text Formatting  29
Spectrum  17
Start Timer  36
Starting Spectrum  16
Startup Device  11, 16
Status  47

Status Line  32
Steps  10
Stop Script  38
Stop Timer  36
Super Serial Card  42
System.Setup  17

T
TCP/IP (v2.5.3) 72
TCP/IP Menu (v2.5.3)  72
Temporary INITs  17
Text Color  29
Text File  23
Timer  36, See also Clock

U
Undo  27
Use Online Display’s Editor  43

W
Word Format  30

X
Xmodem  22, 24
Xon/Xoff Flow  41

Y
Ymodem Batch  24, 51
Ymodem-g  24, 51

Z
Zmodem 24, 52
 (Apple) Menu  21

About Spectrum  21
Desk Accessories  21
Help  21
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Problems

Hopefully you will have none, but if you do, and they cannot be answered by 
reading these notes, please contact me on:

spectrumdaddy@me.com

Other information

Check for the latest version of Marinetti:

http://www.apple2.org/marinetti/

If you do not already know about my other software, please drop by my home 
pages and read more. Amongst other titles there you will find SAM2 an email 
client, SAFE2 an FTP client, and SNAP a Usenet news reader.. 

You will also find on my web site regular updates to my own programs, PDF 
manual versions to many of them, as well as many other files that you might find 
useful:

http://www.wannop.info/speccie/

Someone once said to me, 'Spectrum™ does everything!

Spectrum™ © 1991-2012 Ewen Wannop
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